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PART 1: GETTING STARTED WITH SKY SWAP AI

ON1 Sky Swap AI 2023 is a full-featured app with one overarching goal: to make replacing or enhancing a 
dull sky a breeze. Sky Swap automatically detects skies in your photos and masks them out using AI-based 
technology. Once the mask has been created, you can select a replacement sky from one of the over 100 
skies included with the app, or you can or import your own directly from within the Sky Swap app. 

Sky Swap gives you full control over the mask used to blend the sky, and you can use many of the other 
masking tools to adjust it as needed. You can edit the sky to blend better with your foreground, or even 
blur the sky to simulate a long exposure. Sky Swap can also adjust the foreground lighting and color, and 
add a reflection of the sky to bodies of water in the foreground.

Sky Swap also includes a local adjustment editor, which is designed to help you with your finish editing. 
Using that option, you can create masks of the foreground elements in your photo and adjust standard 
post-processing controls such as exposure, contrast, highlights and shadows, color balance, and much more.

You can use Sky Swap AI as a standalone app, or as a plug-in to a photo editor such as Adobe’s Photoshop, 
Lightroom Classic CC, Photoshop Elements, Affinity Photo, Capture One, Corel PaintShop Pro or Apple’s 
Photos. When used as a standalone, or from within Lightroom, Photoshop or Apple Photos, Sky Swap can 
preserve your edits so you can rework your photos at a later time, without losing your previous work.  
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Getting Help
You can find an extensive collection of 
video tutorials and help documents in the 
Help section of the ON1 website (on1help.
zendesk.com). There, you can search our 
Knowledge Base for frequently asked 
questions, common issues and more. 

Inside Sky Swap AI, you can use the Learning 
Hub to directly display videos for getting 
started with the app, search the ON1 online 
help system—including with an online chat 
assistant—and the ON1 Shop, where you can 
purchase add-ons and courses. 

The Learning Hub is accessible via the Help 
menu or from the Help icon at the bottom of 
the left bumper panel.  

System Requirements
MINIMUM RECOMMENDED

OPERATING SYSTEM macOS 10.15.6 and above; Windows 10/11 
(current maintenance releases, 64-bit only)

macOS 12 or Windows 11 (current 
maintenance releases, 64-bit only)

PROCESSOR Intel or AMD processor with 64-bit support, 2 GHz or faster with SSE 4.2 or later;  
Apple Silicon

RAM 8 GB 16 GB or more

HARD DRIVE 2 GB for installation 2 GB for installation; SSD drive

DISPLAY Windows: DirectX 12, DirectML, Vulkan 
1.1, and OpenGL 4.2 compatible video 
card with 2GB VRAM, 1920x1080 
resolution (at 100% scale factor)

macOS: Metal, Vulkan 1.1, and OpenGL 
4.2 compatible video card with 2GB 
VRAM, 1920x1080 resolution (at 100% 
scale factor)

Windows: DirectX 12, DirectML, Vulkan 
1.1, and OpenGL 4.2 compatible video 
card with 8GB VRAM, 1920x1080 
resolution (at 100% scale factor)

macOS: Metal, Vulkan 1.1, and OpenGL 
4.2 compatible video card with 8GB 
VRAM, 1920x1080 resolution (at 100% 
scale factor)

OPTIONAL 
APPLICATION 
INTEGRATION

Photoshop CC 2020 and above; Photoshop Elements 2020 and above; Photoshop 
Lightroom Classic 2020 and above; Apple Photos; Affinity Photo; Corel Paint Shop 
Pro 2019 and above; Capture One 10 and above

INTERNET A high-speed internet connection and active account for activation, auto-update 
checking, content downloads, and tutorials.

SUPPORTED OPTIONS Supports ICC/ICM profiles for camera input, display, soft-proofing, and printing. 
Hardware display calibration tool is recommended.

LANGUAGES English, German, Spanish, French, Japanese, Korean, Simplified Chinese, Russian, 
Portuguese, Italian, Dutch

The Learning Hub is available directly from within ON1 Sky Swap AI 2023, and includes 
links to videos (which can be played directly in the Hub window), online help system, and 
more.

https://on1help.zendesk.com/hc/en-us
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Installation
To install ON1 Sky Swap AI 2023, you must first 
download and install the ON1 Application 
Manager, which manages your ON1 applications 
and free trials. Once you’ve installed the 
Application Manager, double-click on the app 
icon. You will first be prompted to sign in to your 
ON1 account. The Application Manager will then 
communicate with the ON1 servers, and display 
any apps you already have installed, as well as 
any newer apps that are available for your 
account. To install Sky Swap, choose Available 
from the list on the left side of the window, and 
click on the Install button for the ON1 Sky Swap 
AI 2023 item. The Application Manager will 
install Sky Swap in the proper location, and add 
it to the Installed section. From there, you can 
open the app. The first time you launch Sky 
Swap AI, you’ll need to sign in again to your ON1 
account; after that you’re software will be 
authenticated.

Your license lets you install Sky Swap on two 
computers. When you enter your ON1 account 
info, Sky Swap communicates with the ON1 
activation server and registers your software for 
that computer.

If you wish to move your copy of Sky Swap from 
one registered computer to a new one, and you 
are not going to be using the older machine, 
it is best to sign out of the old computer first. 
Open Sky Swap and select Sign Out from the 
Help menu. This will deactivate Sky Swap on 
the current machine, and you can install and 
sign in on another machine from the Application 
Manager.

FREE TRIAL VERSION

ON1 Sky Swap AI 2023 can also operate as 
a fully featured trial version for 15 days from 
when you first launch it. This gives you time 
to evaluate the product and see if it fits your 
needs. To install Sky Swap as a trial, click on 
the Free Trials label in the Application Manager, 
and click on the Install button. The Application 

The Application Manager is used to install and manage your  ON1 apps and 
plugins. The first time you launch it, you’ll need to sign in with your ON1 
account details.

When using the ON1 Application Manager, the Available section (shown top) 
will list all licensed apps and plugins associated with your account. You can 
install any of those apps by clicking on the Install button, after which they will 
be listed in the Installed section of the Manager.
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Manager will display the number for days left in your trial; to purchase Sky Swap, click on the Buy button in 
the Free Trials section, or the Buy Now button in the top right corner of the Sky Swap window.

MAC INSTALLATION LOCATION
On a Mac, the application is installed in the ON1 Sky Swap AI 2023 folder in the Applications folder. 

If a previous version of ON1’s Sky Swap, Perfect Photo 10 or Perfect Photo Suite is found, it will be 
maintained or replaced based on your preference during installation.

Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folders.

WINDOWS INSTALLATION LOCATION
The application is installed in the ON1 Sky Swap AI 2023 folder in the \Program Files\ON1\ directory. If a 
previous version of ON1’s Sky Swap, Perfect Photo 10 or Perfect Photo Suite is found, it will be maintained 
or replaced based on your preference during installation.

Support files are installed into \ProgramData\ON1\.

UPGRADING FROM PREVIOUS VERSIONS

If you have earlier versions of Sky Swap on your computer, the installation process will move over any 
presets. 

PRODUCT IMPROVEMENT PROGRAM

We believe that the best products are made by listening to our customers. We use many methods to 
gather your ideas and feedback including: emails, surveys, direct conversations, market analysis and the 
Product Improvement Program. The Product Improvement Program is built into our software and gathers 
information about how our software is used. It is the most accurate way for us learn what features are 
important to you and how our products fit into your workflow.

Enrollment in the program is voluntary. When you participate, we collect basic information about how you 
use our programs and basic information about your computer. This information helps us learn what features 
are important to you and how we can make our software easier to use. No personal information is collected 
and you will not be contacted.

You can choose to participate in the Product Improvement Program the first time you launch ON1 Sky 
Swap AI 2023. You can change your participation later, just click the Help menu, then Help Improve ON1 
Products.

To learn more about the Product Improvement Program, go to the Support area of the ON1.com website.

Launching ON1 Sky Swap AI

MACOS

Open the Finder, and navigate to the Applications folder. Find the ON1 Sky Swap AI 2023 folder and open 
it, then double-click on the ON1 Sky Swap AI 2023 application icon.
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You can add ON1 Sky Swap AI 2023 to your dock for easy access by clicking and holding the icon in the 
dock and selecting the Keep In Dock option. If you use Launchpad it can be found there as well.

WINDOWS

Open the Start screen by pressing the Window key; select ON1 Sky Swap AI 2023. If you selected the “Add 
Icon to Desktop” option during installation you can also access ON1 Sky Swap AI 2023 from there.

LAUNCHING SKY SWAP FROM AN EXTERNAL APPLICATION

To launch ON1 Sky Swap AI 2023 from an external application, such as Adobe Photoshop or Lightroom, see 
the sections starting on page 7 for complete instructions.

Uninstalling ON1 Sky Swap AI
To uninstall ON1 Sky Swap AI, first, deactivate your product: open ON1 Sky Swap AI and select Sign Out… 
from the Help menu. (This will allow you to transfer your license to another computer.)

MACOS

Go to the Applications/ON1 Sky Swap AI/Documentation folder. Double-click on the Remove ON1 Sky 
Swap AI application.

WINDOWS

Go to Control Panels; under Programs select Uninstall a program. In the list that comes up select ON1 Sky 
Swap AI and then click on the Uninstall button.

Working with Files
ON1 Sky Swap AI can view and open the following file types, in RGB color mode, at 8 or 16 bits per pixel:

• Raw files from most major camera manufacturers (file extension varies by manufacturer)

• Digital Negative (DNG)

• Photoshop (PSD)

• Photoshop Large Document (PSB)

• Tagged Image File Format (TIFF)

• Joint Photographic Experts Group (JPEG)

• Portable Network Graphic (PNG)

•	 High Efficiency Image Format (HEIC) 

When you finish working on a photo in Sky Swap, you have the option of saving your resulting file in PSD, 
DNG, TIFF, JPEG, and PNG format.
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FILE ACCESS WHEN USING SKY SWAP AI AS A PLUG-IN

If you use ON1 Sky Swap AI as a plug-in from another image editing app (Lightroom, for example), we 
recommend using the Photoshop format (.PSD) as the exchange file format for maximum compatibility. If 
your saved file will be larger than 2GB, or more than 30,000 pixels on a side, your image will automatically 
be saved in the .PSB (or Large Document) format, which is designed for larger file sizes.

Opening a Photo from within Sky Swap AI
When you first launch Sky Swap AI, the main window will have one button: Open Photos.  To start working 
on a photo, you can either drag a photo from your desktop into the window, or you can click on the Open 
Photo button, which will open a photo within the primary Sky Swap window. (See “Working with Sky Swap 
AI” on page 20, for detailed information on using Sky Swap’s tools.)

Once you’ve been using Sky Swap AI as a standalone app for a while, the bottom of the start-up window 
will display the most recently opened files; double-clicking one of those will open the original photo, with 
the settings in place from the previous session. This can be helpful when you wish to re-edit some aspects 
of an earlier session.

On both macOS and Windows, you can also drag a photo on top of the Sky Swap AI icon, which will launch 
the app with that image, bypassing the startup window.

You can edit a photo directly from within ON1 Sky Swap by dragging a file into the window, or by clicking on the Open Photos button. The bottom 
of the window will also display the most recently opened photos from within Sky Swap AI; clicking on one of those will open the original photo, with 
the settings you used in the previous edit.
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Using ON1 Sky Swap AI with Adobe Photoshop
When you edit an image sent from Photoshop to ON1 Sky Swap AI, you are editing Photoshop’s currently 
selected layer. Sky Swap is accessible from within Photoshop in two ways, from the File > Automate menu, 
and from the Filter > ON1 menu. 

Depending upon your workflow, you might wish to work on the primary Photoshop layer, or you might 
want Sky Swap to create a duplicate of the layer when it applies retouching. To do this automatically, you 
must use Sky Swap via the File > Automate menu. 

There are two options for editing an image in ON1 Sky Swap AI: you can send the layer to Sky Swap for 
final editing, or you can save the editing layer as a Smart Object in Photoshop, which will let you re-edit the 
photo in Sky Swap with your previous settings intact.

EDITING A PHOTO FROM PHOTOSHOP FOR FINAL EDITING

To use Sky Swap as a plug-in from within Photoshop, when you do not wish so be able to re-edit your 
operations, follow these steps:

1.	 Open the image you want to work on 
in Photoshop.

2.	 Select the layer you wish to process 
in Sky Swap. 

3.	 From the Filter menu, select ON1 and 
then ON1 Sky Swap AI 2023, or, if 
you’ve chosen to have your working 
layer automatically duplicated, 
choose File > Automate > ON1 Sky 
Swap AI 2023.

4.	 When you’re finished editing your photo, click the Done button in Sky Swap. 

EDITING A PHOTO FROM PHOTOSHOP TO PRESERVE EDITS

To be able to re-edit your Photoshop images at a later point inside ON1 Sky Swap AI, you need to use 
Photoshop’s Smart Object technology. To do this, follow these 
steps:

1.	 Open the image you want to work on in Photoshop.

2.	 Select the layer you want to work on.

3.	 Right-click on the layer and choose Convert to Smart 
Object.

4.	 From the Filter menu, select ON1 > ON1 Sky Swap AI.

5.	 When you’re finished editing your photo, click the Done 
button in Sky Swap.

Use the File > Automate menu in Photoshop when you wish to create a 
duplicate of the current layer when working with Sky Swap

Right-clicking on a layer in Photoshop’s Layers 
panel gives you the option to turn the layer into a 
Smart Object..



ON1 Sky Swap AI 2023 User Guide	 Part 1: Getting Started	 8

To re-edit your Smart Object layer again inside ON1 Sky Swap 
AI, double-click on the ON1 Sky Swap item in the edited Smart 
Object layer in Photoshop. Sky Swap will then launch and let 
you adjust your previous settings or make new ones.

NOTE: Due to the way that Smart Objects work inside 
Photoshop, this method does not use the “Save a copy of 
the layer” from Sky Swap’s Preferences. 

Using ON1 Sky Swap AI with 
Photoshop Elements

When you edit an image sent from Photoshop Elements to Sky Swap AI, you are editing Photoshop 
Elements’ currently selected layer. By default, Sky Swap makes a copy of the layer, so your original layer 
is saved. If you’d like to change this preference, see the Plug-Ins section of the Preferences window (page 
88). Photoshop Elements does not support Smart Objects, so all edits performed in Sky Swap AI are 
final.

EDITING A PHOTO IN PHOTOSHOP ELEMENTS

To use Sky Swap inside Photoshop Elements, follow these steps:

1.	 Open the image you want to work on in Photoshop Elements.

2.	 Select the layer you want to work on. 

3.	 From the Filter menu, select ON1 and then ON1 Sky Swap AI.

4.	 When you’re finished editing your photo, click the Done button in Sky Swap.

Using Sky Swap AI with Adobe Lightroom Classic
ON1 Sky Swap AI can be accessed from within Lightroom Classic CC, providing an integrated, round-trip 
workflow of your images. There are two primary ways to use Sky Swap AI with Lightroom, via the Edit In 
command in the Photo menu and Plug-In Extras command in the File menu. Using the Photo > Edit In menu 
is designed for simple, permanent sky swaps on single images, while File > Plug-In Extras gives you two 
additional, and more powerful, options for editing inside Sky Swap AI, including: 

• Re-editability via ON1’s proprietary Smart Photos format (see page 11), which saves all the 
edits made in Sky Swap, so that you can re-edit them at a later time.

• Batch processing of multiple images, either to automatically swap skies using Sky Swap’s AI 
Auto mode, or to edit multiple photos in more detail (see page 9).

To re-edit a Photoshop layer in Sky Swap, double-
click the module name in the Smart Filters section of 
the Layers palette.
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USING ‘EDIT IN’

To swap a sky on a single image, where you 
don’t need to preserve your edits or work 
with multiple photos, use the Edit In submenu 
from Lightroom’s Photo menu, This is the 
easiest way to send a photo from Lightroom 
to Sky Swap. With this option, you are using 
Lightroom’s plugin export system to control the 
characteristics of the edited file.

To use this method, select your image in Lightroom, go to the Photo menu and select ON1 Sky Swap AI 
2023 from the Edit In submenu.

When you use the Photo > Edit In submenu, Lightroom will ask you each time how you wish to edit the 
selected image. You have three editing options: 

• Edit a Copy with Lightroom Adjustments, which makes a copy of the file that includes any 
edits you have made in the photo;

• Edit a Copy, which copies the original photo without any changes made in Lightroom; or

• Edit Original, which sends the original version of the photo to Sky Swap, unless the photo is a 
raw file, in which case the option will also be unavailable.

In the Copy File Options, you set the file type (TIFF, Photoshop PSD or JPEG), the color space and bit depth 
for the resultant file. PSD is the preferred file type.

When you have set your options and click the Edit button, Lightroom will create a new file (or send the 
original) and launch Sky Swap. There, you can make your edits. When you’re finished, click the Done button 
to save your changes, close Sky Swap, and return the file to Lightroom. To return to Lightroom without 
saving your edits, click Cancel. 

NOTE: While you cannot create a Smart Photo PSD via Edit In, you can open 
an existing Smart Photo with Edit In. Select the Smart Photo, choose Edit In Sky 
Swap AI, and choose Edit Original in the window. Sky Swap will open the image 
with your previous edits intact. Any subsequent edits you make will be saved 
with the Smart Photo when you return to Lightroom. (Information about the 
Smart Photo format starts on page 11.)

USING ‘PLUG-IN EXTRAS’

To use the Plug-In Extras option in Sky Swap, 
select the image in Lightroom, go the File menu 
and select the Plug-In Extras submenu, and 
choose ON1 Sky Swap AI 2023 Standalone. 

For a single-image sky swap from within Lightroom, choose Edit In from 
Lightroom’s Photo menu.
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When you access ON1 Sky Swap AI 2023 through Lightroom’s Plug-In Extras menu, the default file-
handling options are driven by the settings in the Plug-ins tab of Sky Swap AI’s Preferences window. These 
options can be configured in advance, based on your workflow, and can be changed as desired. The file 
export options include the following settings: 

• File Type: This determines what type of 
file will be created. The default is PSD, 
which maintains layers, but does not 
support re-editability. You can also select 
Smart Photo PSD, JPG or TIFF, if you 
prefer those formats. One other option, 
Same as Source, will edit the original file; 
if that file is in the Raw format, it will be 
sent as a PSD file.

• Color Space: The color space menu 
determines which RGB working color 
space is used; Adobe RGB 1998, sRGB or 
ProPhoto RGB.

• Bit Depth: Sets the exported file’s bit 
depth to either 8 or 16 bits per pixel.

• Resolution: Determines the resolution of 
the newly created file.

• Stack with Original: When enabled, the 
new image is stacked with the original image upon return to Lightroom from Sky Swap AI.

• Use Original for Single PSDs: When enabled, if you select a single image in PSD format, the 
original file will be edited, rather than having a copy made.

• Ask Every Time: When checked, 
Lightroom will present these export 
copy options whenever you chose an 
item from the Plug-In Extras submenu. 
Turning this option off will bypass the 
file-export window inside Lightroom, 
using the options set here. 

If you have the Ask Every Time option checked, 
you’ll be presented with the Export window 
(shown on the right) inside Lightroom whenever 
you send an image to Sky Swap AI. The Export 
Options window lets you adjust the file format 
characteristics as needed, and is designed for users 
with variable workflow needs. If you find that you 
use the same options every time, then you can set 
those parameters in Sky Swap AI’s Preferences 
window by unchecking the Ask Every Time option.

When sending a file from Lightroom to Sky Swap AI via Lightroom‘s Plug-In 
Extras menu, the edited file will be created according to your settings in 
the Lightroom section of Plug-ins tab in Sky Swap’s Preferences window 
(highlighted in black, above). 

If you have the Ask Every Time option turned on in Sky Swap’s Plug-Ins 
Preferences window, whenever you send an image from Lightroom to Sky 
Swap, the Export Options window will come up, letting you adjust the 
export characteristics for that image.
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Batch processing options with Plug-In Extras 

You can process multiple images for editing in Sky Swap AI via Plug-In Extras. Select the images you wish 
to work with in Lightroom’s Library module and chose Sky Swap AI from Plug-In Extras. Then, the Export 
Options window will open with three batch options:

• Pause on First Photo: Use this option when you 
wish to apply the exact same editing operations to 
a group of photos. This option will open the first 
selected image inside Sky Swap AI. There, you 
can perform any editing option inside Sky Swap,  
including local adjustments. When you have finished 
with your edits, click Done. Sky Swap AI will then 
swap the skies in all of the photos — using the same 
sky chosen in the first photo – and apply any other 
edits in each image in the group (along with any 
cropping), and return you to Lightroom.

• Pause on All Photos: This option lets you 
sequentially edit the images in the batch. Sky Swap 
AI will open each image in the destination tab, where you can edit it as desired. When you 
are finished editing with one photo, click Done, and Sky Swap AI will save that photo and 
open the next one, with the previous photo’s sky swap settings applied. (You can reset any or 
all of those settings as desired.) When you have finished editing the last photo in the group, 
clicking Done will save the image, close Sky Swap AI and return you to Lightroom.

WORKING WITH SMART PHOTOS

ON1’s Smart Photo technology is a variation of the Photoshop file format that has been engineered to 
preserve all editing operations made within Sky Swap AI: sky replacements, masks, local adjustments, and 
so forth. Smart Photos can only be created via the Plug-In Extras export method as discussed on page 
9, although you can re-edit them via either the Plug-In Extras or the Edit In menu options in Lightroom.

When you choose Smart Photo PSD as an option in the Plug-In Extras submenu from within Lightroom, Sky 
Swap AI creates a standard Photoshop file with “Smart Photo” at the end of the original file’s name. As you 
work in Sky Swap AI, all of your editing operations are saved in a ‘sidecar’ file that sits alongside the PSD on 
disk inside the same folder as your original image. When you are done editing and return to Lightroom, your 
edited photo will look as it did in Sky Swap AI, but is completely re-editable.

To re-edit a Smart Photo from within Lightroom, select the image, and choose Sky Swap AI from either the 
Plug-In Extras from the File menu or Edit In from the Photo menu. Depending upon the method chosen 
and your Sky Swap AI Preferences, the Smart Photo will open automatically, or you will need to select Edit 
Original from the Lightroom export window. �   

There are two things to know about with regards to Smart Photos and re-editability:

• Smart Photos have been specifically designed to work as a conduit between Lightroom and 
Sky Swap AI to preserve re-editability. If you use Sky Swap AI as a standalone app, you can 
open and view a Smart Photo, and can re-edit the photo in Sky Swap AI; as long as your 
sidecar file is present, all of your edits will be present. However, when you complete your 
edits, Sky Swap AI will prompt you to create a new file in any of the available file formats 

The Batch Options window comes up when you wish to 
send a group of photos from Lightroom to Sky Swap AI for 
editing. (If you have the Ask Every Time option set in Sky 
Swap AI’s Preferences, Batch Options will be displayed as 
a section in the Export Options window, and you will be 
able to set the file copy options for the photos in the 
batch.)
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(PSD, PSB, TIFF, JPEG, PNG), and your edits will not be preserved. (The original will remain 
untouched.)

• If you open a Smart Photo in Adobe Photoshop, the layers will be merged into a single, 
composite layer. If you make any edits to the photo and save it, re-editability in Sky Swap AI 
will no longer be available.

Using ON1 Sky Swap AI with Apple Photos
ON1 Sky Swap AI integrates tightly with Apple 
Photos for macOS and provides a seamless 
experience for enhancing your images. 

If you have Photos on your computer when you 
install ON1 Sky Swap AI, the appropriate plug-in 
will be installed, but you will need to manually 
activate it in order to use it. To do so, go to 
Apple’s System Preferences and click on the 
Extensions icon. In the Extensions pane, click on 
Photos, then check the ON1 Sky Swap AI option. 
This will let you send images from Apple Photos 
to Sky Swap AI. (File Sharing must also be turned 
on in System Preferences for this to work.)

To edit an image in ON1 Sky Swap AI follow 
these steps:

1.	 Select the image you wish to edit in 
Photos.

2.	 Click on the Edit button.

3.	 On the right side of the window, right above the editing 
controls, you’ll see an Extensions pop-up (next to the button 
with the heart icon). Click that button, and choose ON1 Sky 
Swap AI 2023.

4.	 The photo will open in Sky Swap; make any adjustments 
you wish, and click the Done button in Sky Swap to save the 
edited photo and return to Photos.

NON-DESTRUCTIVE EDITING WITH APPLE PHOTOS

When you send an image from Apple Photos to Sky Swap, any settings you apply will be saved with 
the image, so that you can send the image back to Sky Swap with your edits intact, as long as you do not 
subsequently edit that image inside Photos. To re-edit an image processed inside Sky Swap, click on the image 
in Photos and follow the same three steps above. When your image is opened inside Sky Swap, you will see 
all of the changes you made in your previous session. 

Once you make any editing changes to your image inside Photos, your Sky Swap edits will be “baked in” to 
the image. You can send the image again to Sky Swap, but your original settings won’t be visible. 

After installing ON1 Sky Swap AI on your Mac, you must turn the Photos 
extension on via Apple’s Extensions System Preference.
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If you wish to keep your original Sky Swap edits, duplicate the image inside Photos (Image > Duplicate), 
which will create a new virtual copy of the file. You can then edit one of the versions in Photos, using the 
other one to preserve your Sky Swap edits.

Using Sky Swap AI with Corel PaintShop Pro
When you edit an image sent from Corel PaintShop Pro (Windows-only) to ON1 Sky Swap AI, you are 
editing PaintShop Pro’s currently selected layer. To use Sky Swap inside PaintShop Pro, follow these steps:

1.	 Open the image you want to work on in PaintShop Pro.

2.	 Select the layer you want to work on. 

3.	 From the Sky Swap AI menu, select PlugIns > ON1 > ON1 Sky Swap AI 2023.

4.	 When you’re finished editing your photo, click the Done button in Sky Swap.

PaintShop Pro does not support nondestructive editing with Sky Swap AI; if you would like to work on 
a copy, before you send the photo to Sky Swap, right-click on the layer in PaintShop Pro and choose 
Duplicate.

Using Sky Swap AI with Affinity Photo
ON1 Sky Swap AI can be accessed from within Affinity Photo, providing an integrated, round-trip workflow 
of your images on both macOS and Windows. To use Sky Swap AI as a plug-in to Affinity Photo, you must 
first activate the plug-in from within Affinity Photo.

ACTIVATING SKY SWAP FOR USE WITH AFFINITY PHOTO (WINDOWS)

1.	 To setup Sky Swap AI as a plug-in on Windows, go first to Edit > Preferences and click on 
the Photoshop Plugins icon. 

2.	 Check the ‘Allow “unknown” plug-ins to be used’ box at the bottom of the screen.

3.	 Click on the Add button underneath the Plugin Search Folders area, and navigate to 
\Program Files\ON1\ON1 Sky Swap AI 2023\Plug-in Files\ON1 Sky Swap AI 2023.plugin. 
Click OK.

4.	 When you click on the Close button, Affinity Photo will prompt you to restart the app. 
When you do this, you should now see Sky Swap AI listed in the Detected Plugins section of 
the Photoshop Plugins preferences.

ACTIVATING SKY SWAP FOR USE WITH AFFINITY PHOTO (MACOS)

Setting Affinity Photo up for macOS has one additional step.

1.	 Go first to Preferences, located in the Affinity Photo menu on the top left. Click on the 
Photoshop Plugins icon. 

2.	 Check the ‘Allow “unknown” plug-ins to be used’ box at the bottom of the screen.

3.	 Click on the Authorize Global button at the bottom of the window. macOS will present you 
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with a dialog box that shows the root folder of your system. Click on the Authorize button in 
this box.

4.	 Click on the Add button underneath the Plugin Search Folders area, and navigate to 
Applications/ON1 Sky Swap AI 2023/Plug-in Files/ON1 Sky Swap AI 2023.plugin. Click OK.

5.	 When you click on the Close button, Affinity Photo will prompt you to restart the app. 
When you do this, you should now see Sky Swap AI listed in the Detected Plugins section of 
the Photoshop Plugins preferences.

EDITING A PHOTO IN SKY SWAP AI FROM WITHIN AFFINITY PHOTO

When you edit an image sent from Affinity Photo to ON1 Sky Swap AI, you are editing Affinity Photo’s 
currently selected layer. To use Sky Swap inside Affinity Photo, follow these steps:

1.	 Open the image you want to work on in Affinity Photo.

2.	 Select the layer you want to work on. 

3.	 From the Sky Swap AI menu, select Filters > Plugins >ON1 > ON1 Sky Swap AI 2023.

4.	 When you’re finished editing your photo, click the Done button in Sky Swap.

Affinity Photo does not support nondestructive editing with Sky Swap AI; if you would like to work on 
a copy, before you send the photo to Sky Swap, right-click on the layer in Affinity Photo and choose 
Duplicate.
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Using Sky Swap AI with Capture One
Similar to Lightroom, Capture One can process either single images or a group of images inside Sky Swap 
AI, and can export those images in a number of different file formats. When you edit images sent from 
Capture One to ON1 Sky Swap AI, Capture One creates a variant of each photo for processing in Sky Swap. 

To edit a single image inside Capture One:

1.	 In Capture One, open and select the photo you wish to open in Sky Swap.

2.	 From the Image menu, select Image > Edit With > ON1 Sky Swap AI 2023.

3.	 Choose the file characteristics you wish to use in Sky Swap—use DNG for the best results—
and click the Edit Variants button to launch ON1 Sky Swap AI.

4.	 When you’re finished processing your photo, click the Done button in Sky Swap AI. Your 
photo will be saved in the selected format and returned to Capture One.

To process multiple images inside Capture One, you select the images you want to work on, and select 
Image > Edit With > ON1 Sky Swap AI 2023. The export window in Capture One will now have an 
additional tab at the top, ON1 Batch. There are two options:

• Pause on First Photo: Use this option when you wish to apply the exact same editing 
operations to a group of photos. This option will open the first selected image inside Sky 
Swap. When you have finished with your edits, click Done. Sky Swap will then apply all of the 
edits — using the same sky — to each image in the group, and return you to Capture One.

• Pause on All Photos: This option lets you sequentially edit the images in the batch. Sky Swap 
will open each image in the main window, where you can process it as desired. When you 
are finished editing with one photo, click Done, and Sky Swap will save that photo and open 
the next one, with the previous photo’s Sky Swap settings applied. (You can reset any or all 
of those settings as desired.) When you have finished editing the last photo in the group, 
clicking Done will save the image, close Sky Swap and return you to Capture One.

When using either the single-image or the batch method, after you’ve returned to Capture One, your 
processed images will be visible in the current collection. 
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Extras
ON1 Sky Swap AI 2023 supports three 
additional file types that can be used within 
the app. These files, called Extras, include the 
following:

• Brush shapes, which are generally 
saved as black-and-white TIF files. 
Sky Swap can also import custom 
brushes saved in the Adobe Brush 
Preset format (.abr). These brushes 
are can be selected and used while 
working in the Local Adjustments 
tab (see page 62).  

• Watermarks, image files 
(transparent PNGs) that can be used 
with the Watermark panes in Sky 
Swap AI’s Export (page 75) and 
Print windows (page 69).

• Skies, replacement skies for use within Sky Swap AI. These skies are automatically added to 
the Category menu in the Sky Swap pane (see “Inside the Sky Swap AI Pane” on page 24).

To manage these files, choose Manage Extras from the File menu. To import either a preset or a brush 
shape, click on the label at the top of the window, then click on the Import button in the footer of the left 
column. A dialog box will appear where you can select the files to import. If you want to import an entire 
folder, open the folder, select the first file, then shift-click on the last file. Click Import when your selection 
is complete. Then, select a category for your extras to live, which is where you will be able to find it inside 
Sky Swap. You can select from an existing category or create a new one.

HOW TO DELETE EXTRAS

You can remove imported extras using the Extras Manager. Follow these steps:

1.	 Open the Extras Manager in any module (File > Manage Extras).

2.	 Click on the extras type that contains the content you wish to remove. This will display 
categories within that type.

3.	 To delete an entire category, select in the left column and click on the Delete button in the 
footer of the left column.

4.	 To delete individual extras, select them in the right column and click on the Delete (‘—’ in the 
Presets tab) button in the footer of the right column.

Deleting extras is permanent and cannot be undone.
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Customizing Sky Swap’s Keyboard Shortcuts
You can customize ON1 Sky Swap AI 2023’s hotkeys 
via the Keyboard Shortcuts window. This window 
lets you view and change the shortcuts for any tool, 
tool option, module, or menu item inside Sky Swap 
AI. You can assign shortcuts to items that don’t yet 
have a shortcut, build multiple sets of shortcuts 
as preset styles, and create a summary of your 
shortcuts that can be viewed in any web browser.

To view or change Sky Swap AI’s hotkeys, choose 
Keyboard Shortcuts from the Edit menu. By default, 
Sky Swap AI’s shortcuts will be displayed, organized 
hierarchically by the following groups: 

• Modules, for moving between the Sky and 
Local tabs.

• Tools, for accessing Sky Swap’s tools. 

• Tool Options, for setting the brush/mask 
hotkeys for the masking tools. 

• Menu, which includes all of Sky Swap AI’s 
menu items. 

You open each group by clicking on the triangle to the left of the group name, or you can use the search 
field at the top of the Keyboard Shortcuts window to search for a command in any of the groups. 

NOTE: Some keyboard shortcuts cannot be changed. These include menu 
commands used by the operating system (Cut, Copy, Paste). Also, you can’t use 
the Escape, Return/Enter, or Delete keys as a shortcut.

Each command that has an assigned key will display that key in the Shortcut column. The Shortcut field 
will be empty for any command that doesn’t have an assigned key, and any field with a grayed-out shortcut 
means that you cannot modify that command’s keys.

MODIFYING SHORTCUTS

The Default preset style’s hotkeys cannot be 
modified, but you can create your own set of 
shortcuts by double-clicking on any command 
you wish to add or change. You’ll be asked if you 
want to create a new preset. Clicking Yes will let 
you name the new preset style, and Sky Swap AI 
will make a duplicate of the Default set.
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At this point, you can change any existing hotkeys—or add your own shortcuts for commands that don’t 
have them—by double-clicking in the Shortcut field for that command. The field will be highlighted, and you 
can press the key or key combination you wish 
to use. If that key is used by another command, a 
dialog will come up, informing you of that, and 
giving you the option of either keeping the 
existing hotkey/command combination, or 
changing it to the new command.

When you change a default shortcut to a new key combination—even for commands and options that didn’t 
initially have a shortcut—a Reset arrow will appear to the right of the Shortcut field. Clicking the icon will 
reset the command to its original state, from the Default preset style.

To delete a shortcut, double-click in the Shortcut field and press the Delete key. 

The Summarize button at the top of the Keyboard Shortcuts window will create an HTML table of the 
current set of hotkeys. You’ll be asked where to save the file, and double-clicking on it will open that table 
in your default web browser, where you can view or print the list. 

You can return to the original Sky Swap AI shortcuts by clicking on the pop-up menu at the top of the 
Keyboard Shortcuts window, and choosing Default from the list of preset styles. That menu can also be 
used to create a new preset or to delete an existing one that you created. The Default preset cannot be 
removed, however.

Using Sky Swap AI with a Scroll Wheel
When you are using ON1 Sky Swap AI 2023 with a mouse that has a scroll wheel, there are number of 
different options available throughout the app, on both Mac and Windows.

Throughout Sky Swap AI, the scroll wheel has the following general options:

• Using the scroll wheel will pan up and down in the current window. In Browse’s Thumbnail 
view, it will scroll the window. In most other views, using the scroll wheel with the cursor 
over the preview area will pan the image on screen up and down. Holding the Shift key down 
and scrolling will pan left or right.

• Hold Option (Mac) or Control (Windows) with the scroll wheel to zoom in or out of an image.

In the Sky and Local tabs, when working with any tool that has a brush size and feather option, press 
Command-Option (Mac) or Control-Alt (Windows) and scroll to change the brush size. To change the 
feather, press Option-Shift (Mac) or Alt-Shift (Windows).

NOTE: If you only want the scroll wheel to change brush size, turn on the 
“Only Adjust Brush Size with Scroll Wheel” option in Sky Swap AI’s Preferences 
window. See “General Settings” on page 86.
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Changing Sky Swap AI’s Font Size
By default, ON1 Sky Swap AI prioritizes the main workspace to focus on photos, using a small font size to 
display panel names, labels, file names any other basic text. You can adjust the default font size to one of 
three settings, Small, Medium or Large, by choosing the General tab of Sky Swap AI’s Preferences window. 
Select the option from the Font Size pop-up, and restart Sky Swap AI to have the effect take place.

ON1 Sky Swap AI has three options for displaying type in the main workspace, Small (left), Medium (middle), and Large (right). To change the size, 
go to the General tab of the Preferences window, and pick the new option from the Font Size window. The change will take effect the next time 
you launch the app.
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PART 2: WORKING WITH SKY SWAP AI
ON1 Sky Swap AI consists of two distinct editing functions, separated into tabs: 

• Sky Swap consists of a single pane that automatically detects the sky in your photo and 
masks it out. Once the mask has been built, you can select a replacement from one of the 
over 100 skies installed with the app, or you can or import your own directly from the pane. 

• Local Adjustments are designed to apply basic, targeted edits to the non-sky portions of your 
photos, letting you perform traditional photo-editing tasks—like dodging and burning—with 
ease. You can also use custom brushes and the Paint with Color option to add overlays like 
clouds, trees, and more to your photos. For more about local adjustments, turn to page 62.

A.	Tool Well: Tools for working within Sky Swap AI.

B.	 Preferences/Help: Shortcuts to app preferences and help.

C.	 Preview Window: Displays the current photo in detail view.

D.	Preview option toggles: Magnification slider for current image, split-screen before/after 
mode, show/hide mask, turn soft proofing and full-screen preview on or off.

E.	 Tool Options bar: Options and settings for currently selected tool.

F.	 Photo Information pane: Navigator, Levels, Info and History panel.

G.	Edit tabs: Switches between Sky Swap and Local Adjustment tabs.

H.	Sky Swap AI pane: Controls and options for the currently replaced sky.

I.	 Reset bar: Reset All (restores settings to the original state when you opened the photos), 
Cancel (closes the photo without saving), Done (closes photo, opens a dialog box to let you 
specify the file name and type of the finished photo).
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J.	 Output: Shortcuts for printing or exporting the current photo. (Sharing is visible on macOS 
only. See page 81.)

Display View Options
In Sky Swap AI, you have three options for viewing the contents of the current window:

• The default is a resizable, movable window.

• Full Screen Mode, which can be found in the Window menu, will expand the main window 
to fit the contents of the current display. The menu bar is hidden, but it can be viewed by 
moving the mouse cursor to the top of the screen. This mode can be toggled on and off by 
pressing Option-Control-F (Windows) or Command-Control-F (macOS).

• Full Screen Preview, also found in the Window menu, will display the currently selected 
photo full-screen, without any of the other interface elements. You can use the arrow keys on 
the keyboard to This option is helpful when you wish to view a selection of photos as large as 
possible without any distractions. 

Sky Swap provides several ways to navigate and view your image in the Preview window:

• By default, your image is presented in Fit view, which displays the image within the preview 
area, and the Zoom tool is selected. Clicking on the image with the Zoom tool will zoom in 
to 100%, and the cursor will change to the Hand tool. You can move around your image by 
clicking and dragging in the preview area. Clicking once will take you back to Fit view.

• You can also zoom in and out via the View menu and the Navigator pane (see below). The 
Navigator pane displays a bounding box around the area currently on-screen, and you can 
reposition what is displayed in the preview area by clicking and dragging the box around the 
pane. Clicking on one of the buttons at the bottom of the Navigator pane will automatically 
zoom to Fit, 100%, 50% or 25% views. (The buttons are also visible in the Zoom tool’s 
Options bar.)

• When the preview zoom is larger than the viewable area, holding down the spacebar will 
display the Hand tool if any editing tool is selected. Clicking and dragging while holding the 
spacebar will reposition your image at the current view level.

Navigator, Levels, Info and History Panes
At the top of the control panel on the right of the main window are the Navigator, Histogram, Info and 
History panes. These tools inspect and view details of your image, as displaying all of the Sky Swap 
adjustments made during a session.

THE NAVIGATOR PANE

This gives you a thumbnail view of your image. The white 
square region marks the image area that is visible in the 
preview pane. You can pan your image by clicking and 
dragging inside the square.
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At the bottom of the Navigator pane are several zoom buttons representing percentage zoom views (100%, 
50% and 25%). Click on one of the buttons to change the view. Fit zooms to fit the current canvas size, 
while 100 zooms to 100%, displaying the actual pixels.

NOTE: You can also use your mouse’s scroll wheel to pan and zoom inside 
your photos. See “Using Sky Swap AI with a Scroll Wheel” on page 18 for 
specifics.

THE LEVELS PANE

This gives you a color chart of the shadow, midtone and highlight 
areas based on the image RGB values (commonly known as a 
histogram). This is useful to show areas within the image that 
may be clipping. Clipping is when your image contains pure 
blacks or white and can signify loss of highlight or shadow detail.

The left side of the histogram represents the shadows, while 
the right represents the highlights. At the top of each end is 
a triangle. If the triangle is lit, there is clipping on that side of 
the histogram. If you click on the arrows, you will activate the 
clipping overlay on your image, which displays the areas that are 
clipped. Those areas with a blue overlay are pure black, while 
the areas with the red overlay are pure white. You can turn the 
clipping view off again by clicking on one of the triangles. You 
can also temporarily enable clipping view by holding down the J 
key at any time. The clipping view is useful when you are making adjusts to the brightness and contrast of 
your image. (See page 59 for more information about using the clipping view.)

The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.

THE INFO PANE

The Info pane displays metadata for the current image in 
an easy-to-read format. This metadata includes camera 
make and model; lens focal length; capture date and 
time; file type; ISO setting; shutter speed; aperture; and 
exposure compensation.

The pane also displays file-specific data, such as name, 
color space, image dimensions and resolution. If any of the 
metadata fields are unavailable they will be left blank.

Settings Applied

At the bottom of the Info pane is a section that shows all 
of the operations that have been applied to the current 
image. Clicking on the right arrow to the left of the label 
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will display a list of every adjustment made, including cropping and retouching. If an image has had any 
adjustments made to it, that section of the Settings Applied area will be represented in white type, and you 
can use the arrows to the left of the label to drill down further into the Sky Swap and Local Adjustment 
tabs to see which adjustments were made to an image. 

Double-clicking on any of the available items inside the Settings Applied area will take you to that specific 
setting inside Sky Swap, where you can make any desired changes.

NOTE: When editing a photo in Sky Swap as a plug-in from Lightroom Classic, 
Photoshop or other supported apps, the Info pane is not visible.

THE HISTORY PANE

ON1 Sky Swap AI has a robust Undo capability, which is 
helpful when you wish to back up a few steps during the 
editing process. When you want to go back further, it can 
be tedious to keep pressing Command/Control-Z. That’s 
where the history pane can be extremely useful. It displays 
every adjustment made during an editing session. From 
the History pane, you can scroll through your edits, all the 
way back to the state of your photo when you opened it 
for editing.

As you work, the History pane tracks all of your edits—
even when working with layered files—adding each change you make to the top of the pane. History 
displays not only the adjustment, but will also display the settings of sliders in the various adjustments. 

You can scroll through the list, and, if you click on an item, Sky Swap will “roll back” your edits to the spot 
you clicked. You can click up and down in the list, and, as long as you don’t make any changes, the entire 
edit history is preserved. If you roll back to an edit and make a change, the History pane “resets” from that 
point on, losing any of the edits you made after the point you rolled back.

The History feature is designed to help you refine and understand the edits you made during an editing 
session; it not saved once you finish editing a photo.  

TIP: If you click on an item in the History pane, and you wish to step up or 
down in the adjustment history from that point, you can use the Undo/Redo 
commands to quickly go through the list. If you are happy with your edits, click 
back on the top item in the History pane to preserve the state of the photo.
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Inside the Sky Swap AI Pane
When you open a photo in Sky Swap AI, the app 
automatically generates a mask of the sky and displays 
the Sky Swap AI pane, which consists of the following 
sections:

A.	Pane controls: on/off button (left) turns the 
replacement on or off; Mask view (right) opens 
the Mask options section for fine-tuning the 
mask. (See page 55 for more.)

B.	 Reset button: returns the Sky pane to its 
original state.

C.	 Styles section: for choosing a specific preset 
sky from within one of the categories, or create 
and apply your own style via the More menu.

D.	Sky selection area: includes pop-up menus for 
the different sky categories, and the skies that 
are part of the currently selected category.

E.	 Import button: launches the Extras Manager 
(see page 16) for importing skies directly 
into Sky Swap.

F.	 Position: lets you choose one of two sky swap 
methods (A or B), shift the horizon line of the 
new sky; set the opacity of the sky; fade and 
shift the edge of the mask; scale the size of the 
new sky to better fit the final image; and apply 
a leveling adjustment to the new sky.

G.	Appearance: sets the warmth and brightness 
of the replacement sky, applies dehaze, and 
lets simulate motion by blurring the clouds and 
setting the blur angle.

H.	Foreground Lighting: lets you adjust the 
intensity and color of the light on the 
foreground.

I.	 Foreground Reflection: when working with 
images that have bodies of water in the foreground, you can add a reflection, adjusting both 
the blending mode, the amount (strength) of the reflected sky, and apply a vertical shift. 

SELECTING A SKY FROM THE SKY SECTION

When Sky Swap AI creates the initial mask of the sky, the original sky will continue to be displayed. Use the 
Category and the Sky menus to apply a sky to the masked area. As you mouse over the different skies in a 
category, Sky Swap AI will show a preview of that sky on your photo. Click on the sky you want, and it will 
be applied. To change your selection, choose a new category (if desired) and sky.    



ON1 Sky Swap AI 2023 User Guide	 Part 2: Working with Sky Swap AI	 25

THE POSITION SLIDERS

After you’ve chosen your sky from the Category and Sky pop-up menus, use the Position section to adjust 
the placement and the blending of the new sky. You can flip the sky horizontally—which can be helpful 
when you wish to change the direction of the light in the sky to match the foreground—by clicking on the 
triangles to the right of the Position label. The Shift Horizon slider will move the imported sky up or down 
inside the masked area, while the Fade Edge and Shift Edge sliders can be used to blend the new sky more 
realistically with the foreground. The Opacity slider will default to 100, which means that none of the 
original sky will show through, but you can lower the opacity to blend the new sky into the image as well. 

The Scale slider will enlarge the new sky’s size inside the mask, which you might do because you want to 
add some drama with larger clouds, or want to emphasize a specific group of clouds, or because the size of 
the size of imported sky doesn’t quite meet the boundaries of your original image.

Method setting

Sky Swap has two types of algorithms that it uses to select skies, Method A and B. For most photos, the 
default option, Method A, will offer the best results, but you might find that there are some instances 
where that option gives you less than optimal results. In those situations, try Method B; Sky Swap will re-
analyze the scene and will create a new mask.

THE APPEARANCE SLIDERS

The sliders in the Appearance section adjust the look of the replacement sky to help better match the sky 
with the existing foreground, and their purpose is straightforward. The Warmth slider lets you apply a 
warmer or cooler look to the new sky, while Brightness adjusts the luminance of the sky, making it brighter 
or darker. Moving the Haze slider to the left removes haze or fog from the sky (by adding contrast), while 
moving it right will enhance it. 

The Blur Amount and Blur Angle sliders let you apply a motion-blur-style effect to the clouds in the 
replacement sky, to simulate a long exposure. 

THE FOREGROUND SLIDERS

As the name of the section implies, 
the Foreground Lighting and 
Reflection sliders apply their settings 
to the foreground and help further 
blend the new sky realistically into 
the scene. To turn on one of the 
groups, click the on/off button to the 
left of the Lighting and Reflection 
labels.

The Lighting sliders attempt to apply 
some of the color of the light in the 
replacement sky to the foreground. 
By default, when you turn the 
Lighting section on, Sky Swap will The Reflection option is designed to add a reflection of your replacement sky to water in the 

foreground (shown on the right above in split-screen preview mode)
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automatically sample a color from the sky and apply a slight color fill effect to the foreground. If you’d like 
to change the color, click on the eyedropper icon next to the color patch, and choose another. The Amount 
slider sets the intensity of the light, while the Distance slider adjusts the effect to fill more or less of the 
entire foreground, almost like a gradient.

There are two blend mode options you can use when adjusting the lighting: Multiply and Screen. Multiply 
will darken the lighting effect, while Screen will lighten it. 

The Reflection group is designed for those times when you have a body of water in the foreground, and 
wish to blend in a slight reflection of the sky into the foreground. 

This option includes a few more of Sky Swap’s blending modes, and you’ll find that different modes 
work  better than others, depending upon the scene. (See page 57 for more information on the various 
blending modes used in Sky Swap and their usage.

The Amount slider adjusts the intensity of the reflection, while the  Shift Vertical slider works in a manner 
similar to the Shift Horizon slider does in the Position section of the Sky Swap pane: it moves the reflection 
of the replacement sky up or down across the foreground area.

Generating Realistic Sky Replacements
Adding a new sky to an image is easy, but getting a sky that looks like it belongs in the image is another 
thing. Here are a few tips for creating realistic-looking sky replacements:

• Quite often, the biggest issue in replacing a sky is matching light, whether it be the direction 
of the light cast by the sun, or the time of day. As you work through the list of skies looking 
for a replacement, ask yourself if the movement of light makes sense in the blended pair. 
Sometimes, you can use the Flip Horizontal toggle in the Position section of the Sky Swap 
pane to fix a directional issue; other times, the potential replacement sky, as much as you 
wish it to work, will just look out of place. (See the illustration on page 27 for more.)

• It will be rare that you pop a sky into an image and that it works perfectly. If the light does 
seem to fit, play with the controls in the Position, Appearance, and Foreground sections to 
get a better sense of how the sky works in the scene.

• As you play with different skies and are trying to get a sense of how one works better than 
another, make use of Sky Swap’s Undo capability; better yet, work with the History pane (see 
page 23) to jump back and forth between different places during your editing session.

• Don’t forget to pay attention to the mask. While the Sky Swap AI technology is excellent, 
it won’t be perfect in every instance. Use Sky Swap’s masking tools to refine and adjust the 
mask in places where your sky might intrude into the foreground or vice versa. And, when 
working with other mask tools, adjusting the Fade Edges slider can often help refine your sky 
mask.

• Copy the sky mask and use it in your local adjustments. You can’t apply a local adjustment to 
the masked sky, but you can use the inverted sky mask in a local adjustment pane. Copy the 
mask from the Sky Swap AI pane by choosing Copy Mask from the Mask menu, then open 
the Local pane, and choose Paste Mask from the Mask menu, and then Invert Mask from the 
same menu. Once you do that, the pane’s settings will only be applied to the foreground. You 
can copy, paste and invert the mask as many times as you’d like.
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NOTE: Detailed discussion regarding the masking and mask-refinement tools 
starts on page 32. More information on how Sky Swap’s masking options 
operate, see page 55

• Shoot your own skies and import them via the Extras Manager. When you’re out and see a 
gorgeous sky, photograph it with as much of the sky as you can catch. Because you’ll have 
shot the sky, you’ll have a better idea of the lighting direction and time of day, which will be 
quite helpful when you are trying to match a sky.  

Paying attention to light, and its direction, is one of the keys to getting realistic-looking sky replacements. As pretty as the as the sunset sky 
is (top left), the direction of the light in the foreground (from behind and to the left) is all wrong for the sunset. The sky on the top right is a 
bit better fit, but the light is coming from the right, clashing with the foreground. Flipping that sky (bottom left) feels more integrated, but it 
still feels dark for the scene, even when adjusting the Brightness slider. Choosing a sky taken at roughly the same time of day (bottom right) 
feels more harmonious with the foreground, and, with a little bit of adjustment, ends up looking fairly realistic.
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The Tool Well
Sky Swap has 16 tools available for you when you are working on a photo, and are accessible via the Tool 
Well on the left side of the screen. Most of the tools are nested within the Local, Mask, Refine and Retouch 
groups, while the Crop and View tools are self-contained within the tool icons. A description of the tools 
and their keyboard shortcuts follows:

• Crop Tool: Trims an image to your desired size or ratio. Shortcut key: C

• Adjustment Brush (Local group): Paints in or out local adjustments. Shortcut  
key: Shift+K

• Adjustable Gradient (Local group): Applies a selective gradient in local 
adjustment mode. Shortcut key: Option+K

• Masking Brush (Mask group): Mask large similar areas quickly. (Includes Perfect 
Brush option.) Shortcut key: B

• Masking Bug (Mask group): Applies a selective gradient as a mask. Shortcut key: M

• AI Quick Mask Tool (Mask group): Generates masks by clicking on regions in a 
photo. Shortcut key: W

• Original Quick Mask Tool (Mask group): Create high-quality masks with only a 
few strokes as guidance. Shortcut key: Command-Option-Shift W (Mac); Control-alt-Shift 
W (Windows)

• Line Mask Tool (Mask group): Create masks using straight lines, with the 
capability to add curves and adjust mask points on the fly. Shortcut key: Shift-P

• Refine Brush (Refine group): Lets you refine an existing mask’s edges, to help 
mask difficult areas, such as hair. Shortcut key: N

• Chisel Tool (Refine group): Removes fringes from the edge of a mask. Shortcut 
key: Shift-H

• Blur Tool (Refine group): Blurs the edges of a masked area to help it blend more 
naturally. Shortcut key: L

• Healing Brush (Retouch group): Paint over a distraction and a matching area of 
your photo is magically blended on top to replace it. Shortcut key: Q 

• Perfect Eraser (Retouch group): Removes distractions like signs and power lines.  
Shortcut key: Shift-Q

• Retouch Brush (Retouch group): Removes blemishes like dust spots and acne. (Includes 
Perfect Brush option.) Shortcut key: R

• Clone Stamp (Retouch group): Paints over an area from a sample of another area. Shortcut key: 
Shift-S

• View Tool: Adjusts the magnification of the image in the Preview area, and lets you move 
around the Preview window. Shortcut key: Z
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ACCESSING AND USING TOOLS

To access a tool, click on the tool or use the shortcut key. When selected, the cursor will change, and you 
will see a set of options for the tool in the Tool Options bar above the Preview window. If the selected tool 
is part of a tool group, you will see the other tools in that group, on the left side of the Tool Options bar.

ADJUSTING TOOL SIZING PARAMETERS

When using any of the tools that have Size and Feather options, you have multiple ways to adjust those 
parameters:

• In the Options Bar for each of those tools, you can use the slider in the Size and Feather 
fields to increase or decrease the amount.

• You can use the left and right bracket keys on your keyboard — ‘ [ ‘ and ‘ ] ’ — to adjust the 
size; additionally, hold down the Shift key to adjust the feather. 

• You can also use your mouse’s scroll wheel. Press Command-Option (Mac) or Control-Alt 
(Windows) and scroll to change the brush size. To change the feather, press Option-Shift 
(Mac) or Alt-Shift (Windows).

• You can also use your pressure-sensitive tablet, if you have one. Settings to turn that option 
on will be found in the Tool Options bar’s Gear menu for the tool.

NOTE: More information about the different ways that you can use your 
mouse’s scroll wheel can be found on page 18.

Each tool in   has an Options Bar, where you can adjust the settings for that tool. Shown here are the options for the Refine Brush.
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CROP TOOL

This tool lets you crop your image, and is fully non-destructive in Sky Swap. The tool also has  a 
content-aware option that lets you expand the photo canvas, filling the edges of a photo’s frame 
with realistic detail.

To crop an image, select the Crop tool, which will display the crop overlay. Select any preset crop ratio you 
would like to use from the Options bar. The default is Freeform, which lets you crop in whatever size or 
ratio you would like. Choosing a preset size (like 4x6) will display the crop overlay at that chosen aspect 
ratio.  

Adjust the corner handles of the crop overlay to get the area you wish. (The area outside the crop box 
appears darkened for guidance.) You can resize and move the image inside the crop box. When you are 
satisfied with your settings, press the Apply button in the Options bar or press Enter.

To move the image inside the crop box, simply click and drag inside the box. You can also nudge the image 
using the arrow keys on your keyboard. To resize the crop box, click and drag on any of the handles. 
Clicking on a corner handle allows you to adjust two sides at the same time; clicking on a side handle allows 
you to adjust that side. If you hold the Shift key down while adjusting the size, the box’s proportions are 
maintained. To rotate the crop box, move outside a corner until the tool changes to rotate.

To straighten an image, you can use the Leveling Tool, which is found in the Tool Options bar when the 
Crop Tool is active. Click on it, and drag the tool across an element in your image that should be level.

Crop overlays

When you select the Crop tool, Sky Swap AI has the option to display guidelines as an overlay on top of 

The Crop interface, with the Crop Preset pop-up open.
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your photo. These overlays can be used as compositional aids for cropping. Sky Swap AI includes a number 
of overlays that you can display during a crop session, and they can be accessed from the overlay pop-up 
menu in the Tool Options bar when the Crop tool is active. There are seven options — Rule of Thirds, Grid, 
Diagonal, Triangles, Golden Ratio, Golden Spiral, and None — and you can easily go back and forth between 
them as desired while cropping. 

In addition to overlay type, there are two other sets of options in the 
menu: 

• You can choose to have the overlay displayed all the time 
during a crop session, or to have Sky Swap AI only display 
the overlay when your cursor is in the preview area of the 
workspace.

• When working with the Triangles or the Golden Spiral 
overlays, the Flip Overlay options will be visible, letting you 
flip the orientation of the overlays horizontally (Golden Spiral 
only) or vertically (Golden Spiral and Triangles).

Content-aware cropping

The content-aware feature lets you extend the crop beyond the edges of the frame. To use this, click the 
Content-Aware option in the Tool Options bar, and move the crop handle past the desired edge. When you 
click Apply, Photo RAW will fill the expanded area with detail based on the content along the existing edge.

The Crop Overlay pop-up 
includes seven options for 
setting and displaying overlays.

When you select the Content-Aware option in the Tool Options bar, you can extend the canvas beyond the boundaries of the existing 
photo. Clicking Apply will fill the area based on the characteristics of the edges in the photo.
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Crop Tool Options Bar:

• Overlay pop-up: Selects a crop overlay, sets overlay visibility, and flips the overlay.

• Preset pop-up: Lets you choose from Freeform, constrained or custom preset ratios.

• Width: Sets the width of the crop box.

• Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.

• Height: Sets the height of the crop box.

• Leveling Tool: Click and drag this tool across an element in your image that should be level.

• Angle: See and adjust the angle of rotation.

• Rotation tools: Rotates the photo 90° clockwise or counterclockwise.

• Reset: Resets the crop area to the size of your original photo.

• Cancel: Cancels the crop application and returns you to where you previously were in the 
Edit module.

• Apply: Applies the crop.

• Content-Aware: When clicked, will expand the canvas size, filling the edges of the photo with 
new detail, based on the area next to the expanded space.

Creating custom crop sizes

In addition to the preset crop 
ratios provided, you can create 
your own custom crop sizes. 
The bottom of the crop preset 
pop-up menu has a Custom 
submenu, which lists all of 
your custom ratios. To add a 
size, choose Manage Custom 
Sizes from the submenu. To 
add a new ratio, click the Add 
button, then enter a name, and 
the width and height ratio you 
wish to create (the units will always be “ratio” when you create a custom preset for the Crop tool). You can 
add as many as you’d like and click OK. The new crop ratios will appear in the Custom submenu.

ADJUSTMENT BRUSH (LOCAL GROUP)

The Adjustment Brush, which is used within the Local Adjustments tab, works like a standard 
masking brush tool, with adjustable sizes, feathering and opacity. You can paint an adjustment 
in or out via the Mode pop-up in the Tool Options bar, and adjust the size and feathering of 
the brush via the bar or with the bracket keys on your keyboard. The Adjustment Brush is 
especially powerful when used with the Perfect Brush option, at the right of the Options bar.

The bottom of the preset pop-up (above left) has a list of custom crop ratios that you can use in addition 
to the preset ratios. You can create your own presets via the Manage Custom Sizes submenu option, 
which opens the Custom Document Size Presets window (above right).
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The Perfect Brush incorporates a color-based, self-masking technology to help create precise selections 
and masks. When you turn the Perfect Brush option on, the Adjustment Brush collects the 
colors under the center of the brush and applies the effect only to those colors. This protects 
the adjustment from being applied across edges. A great of example of using the Perfect 
Brush would be if you wanted to darken the sky in an image, but didn’t want to darken a 
group of mountains on the horizon.

TIP: You can turn the Perfect Brush on and off using the Command-R keyboard 
shortcut (Control-R on Windows). You can also temporarily lock the color to 
remove by holding down the Control key (Windows) or the Command key 
(Mac). This is useful when brushing through areas with a lot of openings like 
tree branches.

Sky Swap AI lets you mask with custom brush shapes when you are using the Adjustment Brush. When you 
use a custom brush on an adjustment layer, in conjunction with that layer’s Paint with Color option, you can 
add overlays and other embellishments. When used with custom brushes, the Manual Spacing option lets 
you control the distribution of the strokes as you brush. 

Adjustment Brush Tool Options

• Style: The Style pop-up lets you save brush information to use at another time. Selecting a 
saved item from the menu will open that saved brush’s characteristics.

• Shape: The Shape menu displays a list of all custom brush shapes in your library. The top item 
in the list is the default, round brush.

• Paint Mode: The paint mode controls if you are painting out (hiding the effect) or painting in 
(restoring the effect). You can tell your current mode by looking at the plus or minus icon in 
the center of the brush. If the icon is minus, you are painting out, and if the icon is a plus, you 
are painting in. You can change the mode in the Tool Options bar, or by pressing the X key, or 
by holding down the Option (Mac) or Alt (Windows) key temporarily.

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work.

• Feather: You control the amount of feathering—or hardness—of the brush by using the 
Feather pop-up in the Tool Options bar. The feather has a range from 1 to 100 percent. Use a 
small feather at high magnification for precise, hard-edged work and a large, soft-edged brush 
in Fit to screen mode for general work. You can visually see your feather by watching the 
outer concentric circle of the brush tool. In addition to the Feather pop-up, you can adjust the 
size of the feather by holding down the Shift key and pressing the right or left bracket keys.

• Opacity: You can control the opacity, or transparency of the brush color, with the Opacity 
pop-up in the Tool Options bar. The opacity has a range from 1 to 100 percent. You use a 
high opacity to paint quickly and hide large areas. You use a lower opacity for blending areas 
together or for subtle work. You can control the opacity in two other ways:

• Press Option (Mac) or Alt (Windows) key on your keyboard and one of the number 
keys. Each number represents an opacity percentage from 10% (1) to 100% (0).

Perfect 
brush icon.
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• Use your pressure-sensitive tablet.

TIP: Opacity is really the shade of gray being painted onto the mask. White 
represents 100% of an effect showing and black represents no effect showing.

• Flow: This is the rate at which the brush color is applied, up to the Opacity setting. With a 
low flow number, as you brush back and forth across a stroke, the brush color will build up to 
the Opacity setting. At a flow of 100, the brush stroke color will be at the Opacity setting. 

• Angle: This sets the angle of the current brush shape. For the default, round brush shape, this 
setting has no effect; it is more useful when working with custom brush shapes. You can also 
rotate the brush shape by pressing Shift-Option (Mac) or Shift-Control (Windows) and the left 
or right bracket keys (‘[‘ or ‘]’).

• Perfect Brush: The Perfect Brush incorporates an automatic edge-detection technology to 
help create precise selections and masks. When you turn the option on—by clicking on the 
Perfect Brush icon in the Options bar—the Masking Brush 
collects the colors under the center of the brush and applies the 
effect only to those colors. This protects the adjustment from 
being applied across edges, such as tree branches. 
	 Further settings for the Perfect Brush can be found by clicking 
on the gear icon in the Tool Options bar. It has these options:

• Color Threshold: This option lets you control the balance 
between keep and drop colors, based on the area you 
are working on. For example, you may want the Perfect 
Brush to be very precise and only paint away very similar 
colors, while at other times you want it to paint away a 
broad range of colors in the same neighborhood.

• Transition: This slider controls the feather of the Perfect 
Brush based on color. To create a soft edge, increase 
the transition. To create a harder edge, decrease the 
transition amount.

• Manual Spacing: When checked, this sets the spacing of the 
brush tip as you apply a stroke. This is primarily used when painting with custom brushes, and 
is generally not applicable inside Sky Swap AI.  

• Pressure options: Sky Swap AI supports pressure-sensitive tablets with the Masking 
Brush. You can enable pressure sensitive controls for the brush size, brush opacity, or both 
simultaneously. To turn this support on, click on the gear icon in the Tool Options bar. You 
can activate pressure sensitivity for both size and opacity by clicking the appropriate buttons 
in the drop-down menu.

Detailed information on using Local Adjustments in ON1 Sky Swap AI 2023 starts on page 62. 

Perfect Brush, spacing and Wacom 
tablet options can be found in the gear 
menu  drop-down.
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ADJUSTABLE GRADIENT TOOL (LOCAL GROUP)

The Gradient Adjustment tool lets you create a linear or radial gradient mask across part of 
your image, The gradient mask goes from dark to light in tone, applying more of the adjustment 
where the gradient is lighter, and less of the adjustment where the gradient’s tone is dark. The 
most common use of gradient masks is to darken the sky in an image, while preserving the 

brightness of the foreground, similar to using a gradient filter on your camera lens.

To apply a standard gradient to a local adjustment, click on the tool, then click in the image roughly where 
you wish the effect to be. You’ll see the outline of the gradient, which is called a bug. You can use the 
handles on the bug to move your gradient, increase or decrease the length of the gradient, or rotate it.

You can change the gradient shape via the Tool Options bar: in addition to the standard dark-to-light 
horizontal gradient, you can also create a circular gradient and a reflected gradient, which is like the 
horizontal gradient, but goes from black (no effect) at the outer edges to white (full effect) in the center.

Adjustable Gradient Tool Options Bar:

• Preset: The preset pop-up includes six settings for the Adjustable Gradient tool (top down, 
bottom up, left and right, and circular vignettes), and changes the current bug (if there is one) 
to match the preset.

• Shape: The shape pop-up controls the shape of the 
bug. In addition to the standard Gradient and the 
Reflected Gradient, there are two radial shapes: 
Center, which puts the light tones at the center 
and the dark tones on the outside of the mask, 
and Edges, which sets the gradient in the opposite 
direction.

• Opacity: Sets the maximum opacity or density of the 
mask.

• Color Range: When enabled, this detects the color under the gradient and applies the mask 
to only that color range. The higher the number, the wider the range of color that is selected.

• Add: Adds a new gradient using the current settings.

• Delete: Deletes the current gradient.

• Reset: Resets the mask on the layer completely. This removes all gradients and clears any 
brushing that has been done.

Manipulating gradient masks

Once you’ve added a gradient to an image, you can modify it by accessing the parts of the gradient overlay:

• To move a gradient, click on the big circle at the center of the gradient and drag.

• To resize a radial gradient, click and drag on the solid line.

• To adjust the feather (hardness) of the mask, click and drag along the dashed line.

The Preset (left) and the Shape (right) options for the 
Adjustable Gradient tool.
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• To rotate the mask, click the smaller circle near the gradient center and drag.

Detailed information on using Local Adjustments in Sky Swap AI starts on page 62.

MASKING BRUSH (MASK GROUP)

The Masking Brush is identical to the Adjustment Brush (see page 55). When you select the 
Masking Brush, your cursor changes to look like two concentric circles, one representing the 
inner hard edge of the brush, and soft outer, feathered edge of the brush. At the center of the 
brush is either a plus or minus. The plus means that you are painting “in” a filter’s effect, while 

minus means the brush mode is set to paint out.

Masking Brush Tool Options

• Style: The Style pop-up lets you save brush information to use at another time. Selecting a 
saved item from the menu will open that saved brush’s characteristics.

• Shape: The Shape menu displays a list of all custom brush shapes in your library. The top item 
in the list is the default, round brush.

• Paint Mode: The paint mode controls if you are painting out (hiding the effect) or painting in 
(restoring the effect). You can tell your current mode by looking at the plus or minus icon in 
the center of the brush. If the icon is minus, you are painting out, and if the icon is a plus, you 
are painting in. You can change the mode in the Tool Options bar, or by pressing the X key, or 
by holding down the option (alt) key temporarily.

NOTE: If you would like to invert the mask (turn it from black to white), in 
order to paint a filter’s effect into your image, select the Masking Brush tool, 
then choose Invert Mask from the Mask menu.

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work. 

• Feather: You control the amount of feathering—or hardness—of the brush by using the 
Feather pop-up in the Tool Options bar. The feather has a range from 1 to 100 percent. Use a 
small feather at high magnification for precise, hard-edged work and a large, soft-edged brush 
in Fit to screen mode for general work. You can visually see your feather by watching the 
outer concentric circle of the brush tool. In addition to the Feather pop-up, you can adjust the 
size of the feather by holding down the Shift key and press the right or left bracket keys.

• Opacity: You can control the opacity, or strength of the brush with the Opacity pop-up in the 
Tool Options bar. The opacity has a range from 1 to 100 percent. You use a high opacity to 
paint quickly and hide large areas. You use a lower opacity for blending areas together or for 
subtle work. You can control the size of the brush several ways:

• Use the Opacity pop-up in the Tool Options bar.
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There will be times when Sky Swap’s automatic mask selection doesn’t work as well as you’d like, 
as shown in the photo at the top (displaying the masked areas as a red overlay). You can easily use 
the Masking Brush to paint out some of the masked areas, refining your mask easily (middle 
photo). The final version, without the overlay, is shown in the bottom photo.
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• Press the option (MacOS) or alt (Windows) key on your keyboard and press one of the 
number keys. Each number represents an opacity percentage from 10% (1) to 90% (9); 
0 represents no opacity.

• Use your pressure-sensitive tablet.

TIP: Think of the opacity as the shade of gray you are painting onto your 
mask. While white in a mask represents 100% of an effect showing and black 
represents no effect showing, all opacity settings in between will show a 
percentage of the effect. This can be very useful when you wish to blend masks 
in a realistic manner.

• Flow: This is the rate at which the brush is applied, up to the Opacity setting. With a low 
flow number, as you brush back and forth across a stroke, the brush color will build up to the 
Opacity setting. At a flow of 100, the brush stroke will be applied at the Opacity setting.

• Angle: Sets the angle of the current brush shape. For the default, round brush, this has no 
effect; it solely for working with custom brushes. You can rotate the brush shape by pressing 
Shift-Option (Mac) or Shift-Control (Windows) and the left or right bracket keys (‘[‘ or ‘]’).

Clicking the gear icon at the left of the Tool Options bar gives you options for the Perfect Brush, brush 
spacing and support for pressure-sensitive tablets:

• Perfect Brush: The Perfect Brush incorporates an automatic 
edge-detection technology to help create precise selections and 
masks. When you turn the option on—by clicking on the Perfect 
Brush icon in the Options bar—the Masking Brush collects the 
colors under the center of the brush and applies the effect only 
to those colors. This protects the adjustment from being applied 
across edges, such as tree branches. 
	 Further settings for the Perfect Brush can be found by clicking 
on the gear icon in the Tool Options bar. It has these options:

• Color Threshold: This option lets you control the balance 
between keep and drop colors, based on the area you 
are working on. For example, you may want the Perfect 
Brush to be very precise and only paint away very similar 
colors, while at other times you want it to paint away a 
broad range of colors in the same neighborhood.

• Transition: This slider controls the feather of the Perfect 
Brush based on color. To create a soft edge, increase the 
transition. To create a harder edge, decrease the transition amount.

TIP: You can toggle the Perfect Brush using Command–R (MacOS) or Control-R 
(Windows). You can also temporarily lock the color to remove by holding 
down the Command (Mac) or Control (Windows) key. This can be useful when 
brushing through areas with a lot of openings, like tree branches.

Perfect Brush, spacing and Wacom 
tablet options can be found in the gear 
menu  drop-down.
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• Manual Spacing: When checked, this sets the spacing of the brush tip as you apply a stroke. 
This is primarily used when painting with custom brushes. 

• Pressure options: Sky Swap supports pressure-sensitive tablets with the Masking Brush. You 
can enable controls for the brush size, brush opacity, or both simultaneously. To turn this on, 
click the gear icon in the Tool Options bar. You can activate pressure sensitivity for size and 
opacity by clicking the appropriate options in the drop-down menu.

Detailed information on using Local Adjustments in ON1 Sky Swap 2023 starts on page 62. There is also 
a short section, “Masking Basics” on page 54, that includes best practices for using the different masking 
tools in Sky Swap.

MASKING BUG (MASK GROUP)

The Masking Bug is used for blending layers by creating radial, gradient and reflected gradient 
mask shapes quickly. It is identical to the Adjustable Gradient tool in the Local Adjustments pane. 
The mask goes from dark to light in tone, applying more of the adjustment where the gradient is 
lighter, and less of the adjustment where the gradient’s tone is dark. The most common use of 

gradient masks is to darken the sky in an image, while preserving the brightness of the foreground, similar 
to using a gradient filter on your camera lens.

To apply a standard gradient to a filter, click the 
Masking Bug, then click in the image roughly where you 
wish the gradient to go. You’ll see the outline of the 
gradient, which is called a bug. You can use the handles 
on the bug to move your gradient around, increase or 
decrease the length of the gradient, or rotate it.

You can change the gradient shape via the Tool Options 
bar: in addition to the standard dark-to-light horizontal 
gradient, you can also create a circular gradient and a 
reflected gradient, which is like the horizontal gradient, 
but goes from black (no effect) at the outer edges to 
white (full effect) in the center.

Masking Bug Tool Options Bar:

• Preset: The preset pop-up includes several common ways to use the tool (linear top down, 
linear bottom up, left and right, and circular vignettes), and changes the current bug (if there 
is one) to match the preset.

• Shape: The shape pop-up controls the shape of the 
bug. In addition to the standard Gradient and the 
Reflected Gradient, there are two radial shapes: 
Center, which puts the light tones at the center 
and the dark tones on the outside of the mask, 
and Edges, which sets the gradient in the opposite 
direction.

• Opacity: Sets the opacity, or density, of the mask.

In this image, a Dynamic Contrast filter has been applied in Sky 
Swap. To keep the effect out of the clouds, a Masking Bug has been 
added.

The Preset (left) and the Shape (right) options for the 
Adjustable Gradient tool.
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• Add: Adds a new gradient using the current settings.

• Delete: Deletes the current gradient.

• Reset: Resets the mask on the layer completely. This removes all gradients and clears any 
brushing that has been done.

Manipulating a Gradient Mask

Once you’ve added a gradient to an image, you can 
modify it easily by accessing the following parts of the 
gradient overlay:

• To move a gradient, click on the large circle at 
the center of the gradient and drag.

• To resize a radial gradient, click and drag on the 
solid line.

• To adjust the feather (or hardness) of the mask, 
click and drag along the dashed line.

• To rotate the mask, click on the smaller circle 
near the center of the gradient and drag.

TIP: To see the mask created by the Masking Bug, and the range of black to 
white tonality, choose Show Mask from the View menu. You can choose either 
a red overlay, which presents the mask over your image, or grayscale, which just 
shows the mask as black to white tones.

Working with Multiple Masking Bugs

You can have up to six Masking Bugs per layer. Each bug is re-editable when you’re using Sky Swap as a 
standalone app, or when you use Smart Object option from within Photoshop (see page 7 for more).

To add another Masking Bug, press the Add button or click outside of the current bug while the Masking 
Bug tool is selected.

Only one Masking Bug may be adjusted at a time. You will see the overlay controls for the active bug while 
your mouse is over the preview area. Inactive bugs are marked with a small circle; to select an inactive bug 
clicking on this small circle marker.

Masking Bugs are subtractive. Each bug hides more and more of the current layer. When Masking Bugs 
overlay each other they may hide more of the layer too. You can always use the Masking Brush to override 
and paint areas back in hidden by the Masking Bugs.
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AI QUICK MASK TOOL (MASK GROUP)

The AI Quick Mask tool is intended to create selections for the current local adjustment — all it 
does it create a mask for that item. 

To use the Quick Mask tool, first create a local adjustment layer in the Local tab. Select the AI 
Quick Mask tool, and move your cursor over the photo. As you move around the photo, Sky Swap will 
display the various regions in your photo as red overlays; clicking on a region will create a selection and 
change the overlay for that area from red to blue. If there are additional regions you wish to select, hover 
over the new area and click. To remove a selection, click on it a second time.

The Mode menu in the AI 
Quick Mask Options bar 
has two options: Paint In 
or Paint Out. Paint In will 
apply the final adjustment 
to the selection created, 
while Paint Out will 
apply the adjustment to 
the areas to the inverse 
of the selection (i.e. the 
areas that have not been 
selected).

While the masks created 
by the Quick Mask 
tool are generated 
automatically, they 
function like any other 
mask. This means you can 
use the other masking 
tools to adjust and refine the finished masks. This also includes the Mask Control options found in local 
adjustment panes (see page 62).

NOTE: The AI Quick Mask tool cannot be used in the Sky tab to select the 
sky. It is intended to be used on areas apart from the sky in the Local tab only. 
If you wish to adjust your sky mask, use the Masking Brush to paint areas in or 
out.

AI Quick Mask Tool Options bar

• Mode: Sets the masking mode for selections. Paint In means that the local adjustment or 
filter will be applied to the selection; Paint Out means that the adjustment or filter will be 
applied to all areas in a photo except for the selection.

Use the AI Quick Mask tool when you wish to create an AI-generated mask on an existing local adjustment layer,.
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• Cancel: Cancels the operation, deselecting the tool and selecting the Zoom tool.

• Done: Creates the mask for the current filter, adjustment or layer and selects the Refine 
brush.

ORIGINAL QUICK MASK TOOL (MASK GROUP)

The Original Quick Mask tool can create high-quality 
masks with just a few strokes as guidance. To use it, just 
mark areas you want to keep in green and areas you 
want to drop in red. When you click Apply, the Original 

Quick Mask tool analyses the color, tone and texture of the marked 
regions to learn what you want to make out and then automatically 
finds the edges and creates the mask for you.  

NOTE: Like the Quick Mask AI tool, the Original Quick Mask tool cannot be 
used in the Sky tab to select the sky. It is intended to be used on areas apart 
from the sky in the Local tab only.

Here are the steps you need to follow to use the Original Quick Mask Tool:

1.	 First, you need to give the tool guidance as to what you want to keep and drop. This is done 
by loosely painting over the regions in your photo. There is no need to precisely paint the 
entire photo: just a few representative strokes of red and green are all that are needed. Paint 
with Drop mode—which is the default brushing mode—over the portions of your image that 
you want to remove. These brushstrokes will appear in red. Then change the tool’s mode to 
Keep (via the Tool Options bar, or by holding the Option/Alt key) and paint over the areas 
you want to keep. These strokes will show up as green.

When you first open the AI Quick Mask tool, you’ll 
see  a window—called the HUD—that includes 
instructions for using the tool.
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2.	 Now press the Apply button in either the Tool Options bar or the Original Quick Mask HUD. 
This will generate a temporary mask to preview the results. Areas that are filled with red will 
be masked out, areas in green will remain. Keep in mind the edges will appear rough at this 
point and will be smoothed out when you generate the final mask.

3.	 If the preview results look good, press the Done button in the Tool Options bar or the 
Original Quick Mask HUD. If there are areas that are incorrect, you can continue to improve 
the results by adding more Keep and Drop strokes. Press Apply each time to preview the 
improved results. When you press Done, the edges are refined with high precision and Sky 
Swap switches to the Refine Mask tool, which you can use over difficult, semi-transparent 
areas—like tree branches—if necessary.

NOTE: The Original Quick Mask tool resets any existing mask previously 
created in the current local adjustment layer.

Original Quick Mask Tool Options Bar 

• Mode: This controls keeping (painting green) or dropping (painting red). Green areas are 
protected in your mask, and are the areas of a layer or filter that will remain. The areas 
marked in red will be removed or masked. In your layer these areas will become transparent. 
On a filter in Sky Swap, these areas will have the filter’s effect removed.  
	 You can tell your current mode by looking at the plus or minus icon in the center of the 
Original Quick Mask brush. If the icon is minus, you are painting drop (red) areas; if the icon is 
a plus, you are painting keep (green) areas. You can change the mode in the Tool Options bar, 
or by pressing the Shift-X key, or by holding down the Option (Alt) key temporarily. 
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• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work. You 
can control the size of the brush several ways: 

• Use the Size pop-up in the Tool Options bar. 

• Use the left and right bracket keys: ‘ [ ‘ and ‘ ] ’ . 

• Use your mouse’s scroll wheel (this option can be set in Sky Swap’s Preferences). 

• Use your pressure-sensitive tablet. 

Further settings for the Original Quick Mask tool can be found by clicking on the gear icon in the Tool 
Options bar. There, you can set the following options (shown below): 

• Pressure Adjusts Size: This option lets you control 
the size of the brush using a pressure sensitive tablet. 
The harder you press, the larger the brush becomes 
up to the current setting of the size slider.  

• Refine Edge: This applies the Refine Mask Brush 
automatically to the edge of the resulting mask, 
creating a more natural transition. This is on by 
default and recommended for most photos.

• Show HUD: This displays the Original Quick Mask 
HUD dialog (shown on page 42), which provides 
guidance on how to use the tool.

• Overlay: Sets the transparency of the red and green mask overlays on top of your image. A 
setting of 100 displays only the mask; the default setting is 50.

LINE MASK TOOL (MASK GROUP)

The Line Mask tool lets you create masks by 
drawing straight lines in your image, with the 
added flexibility of letting you adjust each 
individual line segment into curves to better 

fit the object you want to mask. Masks created with this 
tool are re-editable, can be copied and pasted like any 
other mask inside Sky Swap, and you can have multiple 
Line Mask selections for each mask. 

To start, you click and drag along the outline of the area 
you wish to mask. Clicking your mouse button (or with a 
pen and tablet) adds a point to the line; you can continue 
to click along the edges of your desired selection, and 
the tool will add points along the way. These points will 
be represented by a small square. When you’re finished, 
hover your cursor over the first point and click on it to 
close the path created by the tool. This will close the 
selection and change the cursor to a paint bucket icon; 
click inside the area and Sky Swap will create and the 
display the mask. 

When you complete the mask area by clicking on the original 
point, the cursor will change to a paint bucket icon. Clicking in the 
area will generate the mask, and let you adjust any of the points, 
or add curves for further refinement of the mask edge..



ON1 Sky Swap AI 2023 User Guide	 Part 2: Working with Sky Swap AI	 45

Once you’ve closed the mask, you can adjust the feather and opacity of the mask, and you can further 
adjust the points on the line in the following ways:

• You can click on any point in the selection and move it by dragging it.

• If you hover (or click) on a point, you’ll see a circle appear between that point and the 
previous point on the line. This circle can be dragged in all directions to curve the line to 
better fit the object you are masking.

• Add a point by holding down the Shift key and clicking on the line.

• You can delete any point by right-clicking on it and choosing Delete Point from the pop-up. 

• You can delete the entire mask by choosing Delete Line Mask from the pop-up menu.

While you’re creating the mask, the curve option is always available for the current point; move the cursor 
back over the line before the point and the circle will appear. You can then drag the curve in or out, and 
when you’re done, move the cursor and click on the next place you wish to add a point.

When you’ve made your adjustments to the selection, 
you can click the Done button in the Tool Options bar to 
quit the tool, or you can create another mask. 

To re-edit the mask at a later time, select the filter, layer, 
or adjustment layer that has the mask attached to it and 
choose the Line Mask tool. When you move your cursor 
over the area that contains the mask, the mask’s outline 
will appear in light blue. Click anywhere on the outline, 
and the mask’s points — both square and circle — will 
appear, and you can adjust it as you see fit, even the 
Opacity and Feather settings.

Line Mask Tool Options Bar

• Mode: The mode controls if you are painting out (hiding the effect inside the mask 
boundaries) or painting in (showing the effect).

• Opacity: This controls the opacity, or transparency of the finished mask, from 1 to 100 
percent. At 100 percent, all of the effect will be displayed in the mask area; as the opacity 
level drops, more of the layer underneath the mask will be visible.

• Feather: Controls the hardness of the mask edge. The feather has a range from 1 to 100; 
1 being a hard edge across the boundaries of the mask, 100 being a soft, wide edge that 
‘feathers’ the transition between the masked and unmasked boundaries. 

• Delete: Removes the currently selected line mask.

• Done: Saves the current line masks ad closes the tool, returning Sky Swap to the View Tool.

The curve option—visible when you hover over a point in the 
selection—lets you fine tune the line to make it better fit the 
object you’re masking. (Shown here exaggerated for effect.) 
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REFINE BRUSH (REFINE GROUP)

This tool, one of the most versatile in Sky Swap AI, can be used to clean up intricate areas and 
the borders along a mask. It is helpful for cleaning up a mask created with the Masking Brush, the 
Super Select AI tool, or other masking tools, or for creating a new mask entirely. 

When you paint with the Refine Brush, the brush strokes are displayed as a red overlay, and when you let 
up off the mouse button, Sky Swap AI will work to make the mask edge better defined. 

Refine Brush Tool Options

• Mode: Controls the refinement mode, either Paint Out, which refines to remove from the 
mask, Paint In, which refines to add to the mask, or Auto, which determines the best way to 
refine the mask edge. Paint Out is recommended in most cases.

• Size: This adjusts the size of the brush. Select a brush size that is just larger than the 
intersection of the subject and background. Avoid using oversized brushes it will take longer 
to process and may yield lower quality results. You can use your mouse’s scroll wheel to 
adjust the size of the brush as well (see page 18). Unlike the other masking brushes in Sky 
Swap AI, the Refine Brush has a maximum size of 500 pixels.

• Method: Lets you choose the refinement algorithm and settings 
based on the subject of the masked area. There are five method 
types, plus a user-defined setting that is created when you adjust 
any of the individual parameters found in the Gear menu:

• Original: Uses the refinement algorithm found in earlier 
versions of Sky Swap AI (referred to as Mode 1 in the gear 
menu).

• Hair/Branches: Optimized for fine detail, like hair, 
branches and other subjects.

• Hard Edges: Best method for refining masks with distinct edges between masked and 
unmasked areas.

• Diffuse Edges: Works best on areas where edge detail is not as well-defined.

• Noisy Images: Works well on photos that have higher degrees of noise in them.

The Gear menu includes a setting for controlling the size of the Refine Brush with pressure. It also can be 
used to adjust any of the refine methods in the Method menu. The parameters include:

• Mode (1 or 2): As noted above, Mode 1 is the Refine Brush algorithm used in previous Sky 
Swap AI versions; it remains useful in many masking situations. Mode 2 uses the new (2023) 
version of the Refine algorithm.

• Sensitivity (0-100): Refers to the edge sensitivity; low for diffuse edges, high for hard edges. 
(Works only with Mode 2)

• Locality (0-30): This parameter varies the search for similar scene materials; higher values 
expand the search zone along the brush edges. (Mode 2 only)

The Method pop-up.
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• Smoothness (0-100): Represents post-processing smoothing of the refine results. Higher 
numbers mean smoother edges. (Mode 2 only)

• Noise (0-100): This is a post-processing-based noise filter; use 
higher values with noisier images. (Works with both Mode 1 and 2)

When you change any of the parameters in the Gear menu, those 
results will be applied to the User Defined settings, and will be saved 
until you change them again. In general, however, most of your masking 
refinement work with the Refine Brush should be found in one of the 
five primary Method options.

Working with the Refine Brush

One of the biggest issues with masks is the transitions between edges, 
or in areas where one of the  primary masking tools will miss some 
fine detail. You’ll notice these transitions when you apply an effect or 
adjustment to a masked area, and there will be halos on the mask edges, 
or areas where the effect should be applied, but isn’t. The Refine Brush, 
and, on occasion, the Chisel and Blur tools, can be used to help you fine-
tune your masks and better transitions, ultimately creating more realistic 
masks. 

The Refine Brush is often the first place you’ll want to go when working with masks that could use some 
tuning. Some of the most common operations include:

• You can paint along the edges of a mask that might have areas where the mask isn’t complete, 
or where the transitions between masked and unmasked areas could be smoother. 

• You can paint over large areas of a masked area where there might be fine edges that could 
use further refinement, like trees or hair.

• You can also “encircle” an area in a photo where you wish to add to or subtract from a mask, 
or even create a new mask altogether. 

For simple areas where you wish to refine an edge that has some halos or is otherwise a bit less than ideal, 
set the brush size a bit larger than the area you wish to tune set the appropriate method, and brush over 
the edge. This is shown in the enlarged area below. 

The Gear menu for the Refine Brush has 
options that let you fine-tune the brush 
settings, and saves them in the User 
Defined option for the Method pop-up.

In the photo above, a local adjustment on the sky, masked with Mask AI, left some ugly halos along a treeline. Using the Refine Brush, set to the 
Diffuse Edges method, smoothed the transition properly, making for a better mask. (Effect exaggerated for demonstration purposes.) 
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With tree branches, hair and other areas of fine detail, you can paint over the entire area that you wish the 
mask to refine, as shown in the following graphic.

The Refine Brush’s “encircling method” lets you add to or subtract from an existing mask, or you can use it 
to create your own mask. To do this, use the brush to draw an outline 
around the object you wish to select and mask. What happens next 
depends upon what your intent is, and whether there is already a mask in 
the local adjustment or Sky Swap AI filter you are currently working with:

• If there is a mask already created, and you wish to remove the 
stroked area, choose Paint Out before applying the brush. If you 
wish to add to the existing mask, choose Paint In.

• If there is no mask already present in the adjustment or filter, 
using the Refine Brush and drawing around an object or area 
will create a mask of the encircled space.

For more information about masking inside Sky Swap AI, see “Masking 
Basics” on page 55. 

CHISEL MASK TOOL (REFINE GROUP)

The Chisel tool, accessible vie the Refine Tool Options, bar works to remove fringes or halos 
along the hard edges of a mask; just click and drag along the edges of a mask you wish to refine. 
Fringes are common when the background to be removed is brighter than the foreground. The 
chisel works like a chisel or plane in a wood shop: It removes just a sliver along the edges, and, 

because it only works on the edges, you don’t have to be too careful when using it.

Chisel Mask Tool Options

The Refine Brush is a great choice for adjusting masks with fine details that are often obscured when building masks with some of Sky Swap’s 
primary masking tools. In the screen shots above, you can see the mask of a tree generated automatically with the Mask AI pop-up in a local 
adjustment layer (left). The tree’s interior branches are completely masked. Selecting the Refine Brush, with the Method set to Hair/Branches, 
we’ve painted broad strokes in and around the area where the branches are (center). Sky Swap then refines the mask so that the branches are 
properly masked against the sky, making for a much more realistic mask.

The encircling method.
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• Mode: Select remove or add

• Size: Adjusts the size of the chisel tool. Feel free to use a large chisel to make brushing fast. 
The size of the chisel does not affect how much is chiseled off.

• Amount: Controls the amount of pixels that will be removed or added during each stroke.

TIP: Double-click on the Chisel tool to apply the chisel to the entire mask edge.

BLUR MASK TOOL (REFINE GROUP)

The Blur Mask tool softens edges of the mask where you paint; all you need to do is run the tool 
over the edges you wish to blur. Softening the edges on blurred or semi-transparent subjects like 
hair can make them blend with a new background in a more realistic manner. 

Blur Mask Tool Options

• Mode: Remove/Add/Normal lets you adjust what part of the mask edge to blur. Remove blurs 
and lightens the mask, Add blurs and darkens the mask, Normal blurs both light and darks.

• Size: Adjusts the size of the blur tool. Feel free to use a large size to make brushing fast. The 
size of the brush does not affect the blur amount.

• Amount: Controls the amount of blur. Use a low amount to maintain detail.

TIP: Double-clicking the Blur tool icon applies the blur to the entire mask edge.

HEALING BRUSH (RETOUCH GROUP)

The Healing Brush is a tool for 
removing distractions like dust 
spots, power lines and unwanted 
people from your photos, using 

sophisticated content-aware fill technology. 
Like the other retouching tools, you can 
apply the brush to multiple portions of an 
image. Unlike the other tools, however, the 
Healing Brush is fully non-destructive: each 
area you apply the brush to is individually 
editable (and removable).

To use the brush, paint over a distraction 
and a matching area of your photo will be 
blended on top to replace it, using content-
aware technology. You’ll see two circular 

Areas that use the Healing Brush will be displayed as a gray marker. Clicking on a 
specific marker will let you readjust its placement or delete it.
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markers: red, which is the area that has been removed, and green, which is the area that was used to fill the 
source. Each marker is movable by clicking and dragging; sometimes, you’ll want to try a different area to 
match to your source. Non-active markers will be displayed as gray squares until you click on them. (Press 
the Delete key to remove the current area.)

NOTE: Due to the nature of the replacement sky mask created in the Sky 
tab, Sky Swap’s retouching tools will not work on objects that overlap with 
the replaced sky. If you wish to remove, copy or otherwise retouch areas that 
overlap with a replaced sky, you should perform those operations before using 
Sky Swap AI.

The Healing Brush has four modes, Heal, Stamp, Copy and Move. Each mode has a different approach:

• Heal mode applies content-aware matching from a nearby area to mask the object or area 
being painted out.  

• Stamp mode acts like the Clone Stamp tool (see page 53), applying the actual pixels from 
the area used to mask the object out; unlike that tool, however, this option is non-destructive.

• Copy mode is similar to the Heal mode, except that it makes a copy of the brushed area or 
object instead of masking it out.

• Move mode is similar to Copy mode, except that it masks the brushed area and moves the 
original area to a new location.

Healing Brush modes cannot be changed once they have been applied; if you wish to change the 
application in an area, you must select the old marker, choose Delete from the Tool Options bar, set the 
new mode, and re-brush the chosen area. 

Healing Brush Options

• Brush Size: Adjusts the overall size of the brush.

• Brush Feather: Adjusts the hardness of the brush. 

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften it.

• Mode: sets the type of healing that will be applied when brushing — Heal (content-aware), 
Stamp (pixel-exact), Copy (content-aware) or Move (content-aware).

• Pressure Adjusts Size: If you have a pressure sensitive tablet, you can adjust the size of the 
brush according to the pressure. Click the button to activate.

Transforming retouched areas

As noted, all applications of the Healing Brush are non-destructive, meaning that you can adjust the source 
and destination areas for each marker, and you can delete markers by clicking on the appropriate market 
and choosing Delete from the Tool Options bar (or by pressing the Delete key).



ON1 Sky Swap AI 2023 User Guide	 Part 2: Working with Sky Swap AI	 51

You can also transform individual destination markers in a photo by holding down the Option/Alt key (Mac/
Windows) and hovering over the area. When you do this, a box will appear over the currently selected 
destination marker. You can resize the selection by adjusting the handles on the box; to resize 
proportionally, hold down the Shift key. You can also rotate the selection by clicking outside the box and 
pressing the mouse key, or you can flip the selected area vertically or horizontally by clicking the icons 
underneath the box.

PERFECT ERASER (RETOUCH GROUP)

The Perfect Eraser can be used to remove distracting blemishes from your portrait. It uses 
a content-aware algorithm that replaces the pixels with a natural-looking result within the 
boundaries that are painted.

NOTE: Due to the nature of the replacement sky mask created in the Sky tab, 
Sky Swap’s retouching tools will not work on objects that overlay the replaced 
sky. If you wish to remove, copy or otherwise retouch areas that overlap with a 
replaced sky, you should perform those operations before using Sky Swap AI.

Using the tool is easy: paint over the area you wish to remove, making sure you cover the entire area. A 
red overlay appears where you paint. If the first attempt does not give you a perfect result, paint over it 

When you hold down the Option or Alt key and hover over the currently selected Healing Brush marker, a box appears, which lets you 
adjust the size, rotation and orientation of the marker. When used in conjunction with the Healing Brush’s Copy or Move modes, you 
can easily duplicate and transform individual subjects within your frame, as shown by the copy of the pronghorn above..
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again and it will improve with each pass. You can also fine tune the area after applying the tool by using the 
Retouch Brush (see below).

Perfect Eraser Options

The Perfect Eraser’s Tool Options bar consists of two options; brush size, and Wacom tablet support The 
default brush size for the Perfect Eraser is 125 pixels; you can make this bigger or smaller by clicking on 
the Brush Size in the Tool Options bar, or by pressing the right or left bracket keys on your keyboard. The 
maximum brush size is 500 pixels. If you have a Wacom pressure-sensitive tablet, select the Pressure 
Adjusts Size button in the Options bar.

RETOUCH BRUSH (RETOUCH GROUP)

Use the Retouch Brush to remove small imperfections. Dab the brush on areas that contain spots 
or other imperfections, such as acne, or moles. The tool looks at the neighboring areas in your 
image and fills in the brushed area with an area of similar color and texture.

NOTE: Due to the nature of the replacement sky mask created in the Sky tab, 
Sky Swap’s retouching tools will not work on objects that overlay the replaced 
sky. If you wish to remove, copy or otherwise retouch areas that overlap with a 
replaced sky, you should perform those operations before using Sky Swap AI.

It is best to use the smallest brush size possible and to work by dabbing rather than making large brush 
strokes. If you dab with the brush and don’t like the results, use the Undo command and try using a smaller 
brush or vary your brush stroke and try again. 

Retouch Brush Options

• Brush Size: This adjusts the overall size of the brush.

• Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.

• Pressure Adjusts Size: Click on the button to activate the Wacom sensitivity controls.
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CLONE STAMP (RETOUCH GROUP)

Use the Clone Stamp tool to replace an area of a photo with an area from a different part. Hold 
down Option (Mac) or Alt (Windows) and click the area you want to clone from. Then click and 
drag on the area you want to clone over and it will clone from the point you selected.

NOTE: Due to the nature of the replacement sky mask created in the Sky tab, 
Sky Swap’s retouching tools will not work on objects that overlay the replaced 
sky. If you wish to remove, copy or otherwise retouch areas that overlap with a 
replaced sky, you should perform those operations before using Sky Swap AI.

Clone Stamp Tool Options:

• Brush Size: This adjusts the overall size of the brush.

• Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.

• Pressure Adjusts Size: If you have a Wacom pressure sensitive tablet, you can adjust the size 
of the brush according to the pressure. Click the button to activate.

VIEW (ZOOM) TOOL

This tool, which is the default tool selected when you open an image in Sky Swap, adjusts the 
magnification of the image in the Preview window. With the Zoom tool selected, click in the 
Preview window to zoom in and center the image at the location clicked. Hold down the Option/
Alt key to display the Hand tool, which lets you pan around the magnified image. You can also 

double-click the Zoom tool in the Tool Well to set the image to 1:1 (or 100%) magnification view, which 
shows every pixel. This is best when examining small details.
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Masking Basics
One of Sky Swap’s most powerful features is its masking 
capabilities. The Sky Swap pane also has its own AI-
generated mask of the sky, and every adjustment panel in 
the Local tab can have a mask associated with it. 

NOTE: Most of the masking and retouching 
tools are designed to work in Sky Swap’s Local 
tab, although some, like the Masking Brush, can 
be used to fine-tune the mask in the Sky pane.

At its simplest level, a mask shows or hides the effect of the 
filter or adjustment. Masks have no color: they are grayscale, 
and the tones range from pure white to pure black. A mask 
that is completely white displays the entirety of the effect 
being used, a mask that is completely black hides that effect. 
(A common way to remember it is via the phrase “black 
conceals, white reveals.”) Shades of gray are in effect the 
opacity of the mask. Darker shades reduce the effect, lighter 
shades let more of it through.

The beauty of the masks is that you can paint on them with 
black, white or any shade in between, so you can “mask” 
portions of your photo so that they will not have that 
effect—or will have a reduced effect. You can also copy 
masks from one adjustment layer and paste them into other 
layers. Using this feature, you can mask out the subject in 
one adjustment layer, copy the mask, paste it into another 
adjustment layer and invert it, applying a different effect 
to everything but the sky. Sky Swap even lets you create 
luminosity masks, which are masks that are solely based on 
the brightness of the pixels in the image. You can view your 
masks, either as a red overlay or as the grayscale version of 
the actual mask, which can be helpful when you wish to look at the edges of mask.

Creating masks are as simple as choosing an area with the Mask AI tool from the Add Adjustment button, or 
by using a masking brush or by placing an adjustable gradient. You can also use multiple tools and masking 
functions to create more complex masks. For instance, you can drop a gradient on a photo, use the Masking 
Brush to paint in places where don’t want the gradient applied, or you can use the Color Range tools (found 
in the Masking Control Options area) to select portions of an image based on color. 

THE MASKING TOOLS AND VIEW OPTIONS

Inside ON1 Sky Swap AI 2023, there are five basic tools that can be used to create masks: the Masking 
Brush, the Masking Bug, the Quick Mask AI, Original Quick Mask and Line Mask tools. There are variants of 

Two views of a local adjustment layer mask, along 
with the Masking Control Options section. When you 
first add a local adjustment, the mask is black (A), 
which means that none of that layer’s adjustments are 
applied to the photo. If you use the Mask AI option to 
generate a mask automatically, or if you use the 
Adjustment Brush or Adjustable Gradient to manually 
create a mask, the areas masked out (partially or 
completely) will be shown in the filter’s mask view (B). 
And, whenever you click on the mask icon in the 
pane, it will open the Masking Control Options 
section, which includes settings for displaying, 
copying and pasting, and fine tuning that mask (C)
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the first two that are specific to Local Adjustments (Adjustable Brush and Adjustable Gradient). The Quick 
Mask AI tool — along with the Mask AI tool in a local adjustment layer (see page 62) — generate masks 
automatically, based on known regions in your photos.

You can use the gradient and masking brush tools cumulatively, meaning that you can add to or subtract 
from the current mask. However, if you select the AI Quick Mask tool, it will replace any existing masks on 
that pane or layer. However, once you’ve created a mask with the AI Quick Mask tool, you can add and 
refine that mask with the other tools.

The Refine group of tools—Blur, Chisel and Refine—are designed to help work with edges and halos that can 
crop up when you have areas of strong contrast between a masked area and an unmasked one.

In addition to the masking 
tools, each mask has a set 
of controls you can use 
to manipulate the mask 
to refine it further (see 
“Masking control options,” 
below for more). 

When you add a filter 
or a layer, the mask is 
technically hidden. You can 
create a mask by either 
using one of the masking 
tools, or by clicking the 
Show/Hide Mask icon in 
the title bar of the pane, to 
the right of the filter name. 
The contents of the Show 
Mask icon will represent 
the mask on that layer. 
(Local Adjustment panes automatically create a black layer mask, so you can ‘paint in’ the adjustment to the 
image.)

Sky Swap has two primary options for viewing the contents of a mask: either as a red overlay on top of 
your image (the default) or a view only of the mask itself, represented as grayscale. You can turn the mask 
overlay on or off by pressing the ‘O’ key on your keyboard. 

The grayscale view can be helpful when checking edges, or when refining some of the advanced masking 
controls. These mask view options are available from the Mask menu; select Show Mask to see the mask, 
while the View Mode option lets you switch between the two modes. You can also set the app to display 
the red overlay only when you are brushing with the Masking Brush and its cousins.

When you’re viewing a mask in either overlay or grayscale modes — or even when you aren’t actually 
viewing it — you have access to all of the tools in the Edit module. You can zoom in, to view the mask in 
greater detail, can use the Refine masking tools to adjust the fine edges of your mask. You can also use any 
of the other masking control options found in the Mask control options, as described below.

Here is a local adjustment—using the Adjustable Gradient tool—that has been applied to a photo to lighten the 
foreground after the sky has been swapped. The Show Mask option has been turned on, so you can see where 
the effect has been masked out (shown in red). The gradient mask is softer at the bottom of the gradient, and 
entirely opaque at the top of the gradient. These smooth transitions can create a better look for your photos.
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MASKING CONTROL OPTIONS

When you click on the Mask icon at the top of a local adjustment layer, Sky Swap AI will display a set of 
options for that mask. This section has the following contents, as shown below:

A.	The Show/Hide Mask icon, which displays the 
contents of the current mask. The default mask 
is white when you add an effect, and black when 
you add a local adjustment layer.

B.	 Buttons for opening the blending options, 
resetting the filter, and removing the filter.

C.	 Sets the overall opacity of the effect.

D.	Mask AI pop-up for selecting an area based on 
region.

E.	 Larger display of the current mask, option to 
invert, reset, copy, paste, create a luminosity 
mask, and view/hide the mask.

F.	 Density adjusts the overall density from black 
(100) to white (0). Feather blurs the mask. Levels 
and Window let you adjust the black and white 
points of the mask, fine tuning them in different 
ways.

G.	The Color Range option lets you choose a color 
and make or tune the mask based on the range of 
the color selected.

H.	Contents of the Mask AI pop-up menu, when 
clicked.

The buttons at the top portion of the Mask Options can be 
quite helpful, especially when you’re working with complex 
masks, or when you wish to reuse masks in other parts of 
Sky Swap. There functions are as follows:

• Invert reverses the contents of the mask, swapping the tones.

• The Reset button erases the current mask, leaving it filled with white. 

• The Copy and Paste buttons let you copy the current mask, to paste it into another filter, 
local adjustment or layer. 

• The View button toggles the Mask View on and off.

• The Lumen button creates a luminosity mask of the image for the current filter, adjustment or 
layer, replacing any existing masks. 

Color Range selections

The Color Range option lets you create a mask using a specific color, either one inside your image, or one 
via your system’s color picker. To use this option, click the On button next to the Color Range section, and 
click the eyedropper tool to select a color inside your image that you wish to sample. You can then use the 

Overview of the Mask Options section.
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slider to expand or contract your mask based on that color: lower numbers means that fewer colors (related 
to the chosen color) will be selected, higher numbers mean a wider range of will be selected.

The Color Range option found in the Gradient masking tools can be controlled from the Mask Options 
section of the pane. When you add a gradient mask and click on the Color Range option in the Tool Options 
bar, the color chosen is sampled from the center of the gradient control, but you can open the Mask 
Options pane and sample a different color using the eyedropper. Note that if you do this, and move the 
masking bug, it will resample using the color from the center of the bug. 

BLENDING MODES

In addition to opacity, you have one other very powerful option for adjusting the strength and effect of a 
filter: blending modes. Blend modes determine how a filter interacts with the filters below it in the image 
stack. Blend modes can darken or lighten an image, depending upon the mode chosen, while others adjust 
contrast or color. ON1 Sky Swap 2023’s blend modes also let you apply a blend mode to specific colors 
or tones in your image, making them a very useful tool for precision editing of your images. You can apply 
sharpening, for example, only to the midtones in an image, which can be very helpful in a landscape image.

To see the blending modes, click on the Blending Options gear icon at the top of a filter’s pane. The 
Blending Options area will drop down from the top of the panel. The blending option controls are:

• Blending Options: A pop-up list of blending modes. There are 24 common blending modes 
available in the list, including Normal, Screen, Multiply, Soft Light Overlay and Color.

• Apply To: This lets you apply the blending mode to a specific color or tonal range. The 
options are; All (the default), Highlights, Midtones, Shadows, Reds, Greens, Blues, Magentas, 
Cyans, Yellows, Flesh Colors, Vivid Colors and Neutrals. (You can also manually choose a 
color range by selecting the Dropper Tool in the pane and clicking on a color in your image.)

When you choose one of the options, the adjustment is only applied to that part of the image that is based 
on the lightness, hue, or saturation range specified. The Range slider expands or contracts the selected 
option, and the Highlights, Shadows, and Skin sliders protect those settings from your adjustments.

How blending modes work

At their basic level, blend modes determine how 
the pixels on one layer interact with the layers 
below it. With 24 blend modes in ON1 Sky Swap 
2023, it might be difficult to know which ones 
to use in any given situation, but they can easily 
be grouped into Normal (the default mode) 
and five categories: Darken, Lighten, Contrast, 
Comparison, and Color/Luminosity. 

Normal is the most widely used: it simply applies 
the effect to all of the pixels in the adjustment 
(or effect), assuming the layer opacity is 100%.

The other modes apply different levels of that 
category’s effect using various mathematical 
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formulas, and sometimes it can be hard to know which mode will work best with what photo. Most often, 
when you know how you want to apply an effect —by darkening, for example—you’ll need to perform a bit 
of experimentation with the different modes in that category to determine which mode works best.

Sky Swap Preview Options
ON1 Sky Swap AI 2023 offers a few different 
previewing options, all of which can be found 
in the previewing section at the bottom of the 
window. With these options, you can compare 
the before and after views of a photo—in either 
split-screen or full-screen views—see the current mask, and turn soft proofing on or off. You can also view 
both clipping and focus masks via the View menu. 

CHANGING THE MAGNIFICATION VIEW 

Sky Swap AI includes various options for zooming in or out of a photo while you’re working on it. In 
addition to the Zoom tool and the Navigation pane (see page 20 and page 21, respectively), you can 
change the zoom view by moving the magnification slider. You can either click on the control and slide it to 
the right to zoom in and to the left to zoom out, or you can click on the boxes at the ends of the slider.

BEFORE/AFTER PREVIEWS

As you work in Sky Swap, it can be helpful to see how your edits affect your photo. Sky Swap’s Compare 
mode displays a side-by-side view of your photo, with the original version on the left, the edited version 

The Preview area at the bottom of the main Sky Swap AI window includes 
options for adjusting the preview magnification, turning compare (before/after) 
view on or off, viewing the current mask, turning soft proofing on or off, and 
for viewing the original photo, with all edits removed.

Sky Swap’s Compare view displays a before/after view of your current photo, with a movable slider (circled, above) for expanding and 
contracting the different views.
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on the right. There is a movable slider in the middle of the screen, which lets you view more or less of each 
view; click on the box at the center of the slider and drag it to the left (to view more of the edited image) 
or to the right (to view more of the original. While working in Compare view, you can use the magnification 
slider to zoom in or out of the image, which can be useful when you wish to see the effects of your edits on 
smaller sections of your photo.

You can also view your original image full-screen by clicking the Preview button at the far right of the 
previewing toolbar. When you click this button, the original photo is displayed with a “Preview Off” overlay. 
To return to your edited version, click the Preview button again. (You can also use the backslash key—‘\’—to 
show and hide the full-screen preview.)

SHOW/HIDE MASK

When ON1 Sky Swap AI 2023 adds a sky, it creates a ‘mask,’ which separates the sky area from the other 
regions of the photo. Most of the time, when you’re working in Sky Swap, you won’t need to adjust the 
mask. But you can view the current mask (either in the Sky tab or the Local tab) by pressing the Show Mask 
button in the previewing section at the bottom of the screen. Clicking this button will display a transparent 
red overlay, where the masked sections of your photo are shown in red (the overlay can be changed to 
black and white via the Mask menu). For information about painting a masked area in or out, see “Masking 
Basics” on page 54.

FOCUS AND CLIPPING VIEWS

Two additional previewing tools that can be powerful aids when you are retouching photos are the Clipping 
and Focus Mask overlays. 

Clipping

Clipping occurs when the shadow and highlight tones in an image are suddenly cut off to completely white 
or black, rather than fading smoothly. (Large expanses of white pixels in a photo are often referred as 
‘blown’ highlights, and can be quite distracting to a viewer.) One of the benefits of shooting in raw format 

Clipping view displays pure white pixels with a bright red overlay, and pure 
black pixels with a bright blue overlay. 

Focus Mask displays areas of sharpness with a green overlay.
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is that, while many photos will have areas of pure white or black when originally viewed on-screen, there 
is still recoverable data in the raw image. The Clipping overlay can help determine how big a problem you 
might have with a photo, and how easy (or difficult) it will be to fix. 

To display the Clipping overlay temporarily, press the J key; to turn it on permanently as you move from 
photo to photo, choose View > Show Clipping, or press Alt (Windows) or Option (Mac) J on your keyboard.

The Clipping view overlay displays the areas that have either pure white or pure black in them. Those areas 
with a bright blue overlay indicate pure black pixels, while the areas with the bright red overlay indicate 
pure white pixels.

Focus Mask

It can often be difficult to view the sharpness in a photo without zooming in to 100% or more, and if you 
have a lot of photos from a shoot, it can be a bit tedious to check focus at that level. Luckily, Sky Swap AI’s 
Focus Mask overlay can help winnow your shots down to the sharpest ones.

To turn on Focus Mask, choose View > Show Focus Mask, or press Shift-Alt-J (Windows) or Shift-Option-J 
(Mac). The sharpest areas in your image will be represented by a bright green overlay. As you move from 
photo to photo in a folder, you’ll be able to tell whether you have an acceptable level of sharpness where 
you need it by the strength of the overlay. The mask will continue to be displayed even as you zoom in on a 
photo. 

SOFT PROOFING

ON1 Sky Swap AI’s soft proofing feature lets you see how a photo will look when printed, using the color 
profiles that get installed with your printer. Soft proofing helps you determine where there might be issues 
when you print, so that you can adjust your tone, color and effects to give you a print that is closer to your 
editing vision.

Normally, when you’re viewing an image in Sky Swap AI, you are viewing it through the lens of your 
monitor’s display profile. The color gamut of your computer’s display is wider than that of most photo 
printers, which means that some colors you are able to view on-screen are not reproducible when you print. 
When this happens, the color profile conversion that happens in the print engine will cause substitutions of 
colors that the printer cannot print to the closest color that it can. This means that your image could have 
subtle (or broad) shifts in color, especially in certain color ranges.

Soft proofing is turned on via the View menu, or by clicking on the soft proofing icon to the left of the 
Preview button at the bottom of the main Sky Swap AI window. You soft-proof various paper types by 
choosing an installed printer profile from the Profiles submenu. The image will change to approximate the 
color of the paper you’re profiling. You can also turn on an overlay 
that will display out-of-gamut colors.

The primary soft-proofing options are available underneath the 
Enable Soft Proofing item in the View menu. The options are as 
follows:

• Gamut warning: When checked, this displays colors in 
the image (via a red overlay) that don’t correspond to the 
current printer profile being soft proofed.

The Profiles submenu displays the installed printer 
profiles for any installed photo printer. You can also 
import your own color profiles.
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• Profiles: The Profiles submenu lists the currently available printer profiles. Choosing one 
will change the on-screen display to use that profile. You can also import profiles via this 
submenu.

• Intent: Sky Swap AI offers two different rendering “intents” when soft proofing, which are 
used to convert the color from display to print. Perceptual shrinks the color gamut during 
the conversion, which works to preserve the relationship between colors in the image. The 
other intent type, Relative, only converts colors that are outside the current color gamut, 
but this can sometimes cause two colors, one in gamut, and one outside, to be identical after 
conversion.  
	 Neither rendering intent is perfect or desired; it often is a matter of the makeup of the 
image, your editing intent, the paper being printed on, and so forth. Often, you’ll want to 
switch back and forth between Relative and Perceptual, seeing which gives you a better print.

• Simulate Paper and Ink: Turning this setting on will cause Sky Swap AI to use the white point 
for the chosen paper type (instead of the white point of your monitor), and the paper’s actual 
black density (instead of the display’s black point). If you’re trying to match a print, you will 
usually want this setting turned on.

Adjusting images with soft proofing is often a bit of trial and error. It’s easy to get caught up in eliminating 
out-of-gamut colors, but most modern photo printers—both home printers and online print services—do a 
pretty good job of properly approximating colors. 

The biggest thing you want to be looking for when viewing a soft proof is tone, contrast and color accuracy 
between screen and print. When using a home printer, use test prints to hone in on the right mix of 
adjustments. 

These three screen shots show the results of soft proofing options, as viewed in Sky Swap AI. The left image is with soft proofing off (and is using the display 
color profile). The middle image is with soft proofing turned on, and using a printer profile for Epson’s Legacy Fibre Paper. The bottom image has the Gamut 
warning turned on; out of gamut colors are highlighted by the bright red overlay.
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PART 3: USING LOCAL ADJUSTMENTS
You can easily make targeted tonal and color adjustments to 
specific areas of a photo while you’re working inside Sky Swap AI. 
These localized edits let you apply editing touches to areas of a 
photo, to enhance your subjects, backgrounds and other elements 
in the frame. 

NOTE: Due to the nature of the sky mask created 
in the Sky tab, you cannot use local adjustments to 
adjust the replaced sky. The basic masking, mask 
refinement tools, and the retouching tools will only 
work on areas other than the sky.

You can create local adjustments using the Adjustment Brush or 
the Adjustable Gradient tools, but you can also use ON1’s Mask AI 
technology to automatically select areas in a photo.  

You can create as many local adjustments as you need on an image 
by clicking on the Add Adjustment button at the top of the Local 
Adjustments section. If you’d like to use the Mask AI feature, hold 
the mouse button down on the button, and choose the appropriate 
region for which you wish to apply a local adjustment. ON1 Sky 
Swap AI will create the mask and open the new pane in the Local 
Adjustments stack.

Local adjustments can be used to apply a gradient filter to 
lighten or darken the foreground, for example, or to add a more 

You can use the Mask AI feature to add a new local 
adjustment layer by clicking and holding on the Add 
Adjustment button at the top of the Local tab. The regions in 
the current photo will be labeled.
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complicated vignette to an image. Local adjustments are in essence a mask that is applied to a portion of 
your image, and you can manipulate those masks in powerful ways with both the blending modes and the 
luminosity options in the Local tabs.

Operations you can perform with local adjustments include tone (exposure, contrast, highlights and 
shadows, detail), color (white balance, saturation and vibrance) and detail (structure, dehaze and noise). 
Each adjustment layer can have different settings and can work on different parts of your image. You can 
also use local adjustments to paint with color over part of a photo, to perform specialized tasks such as skin 
retouching or to replace the color of an object. 

Local adjustments are independent from the Sky Swap tab; you can create a local adjustment, return to the 
Sky tab to work for a bit, and when you click on the Local tab again, your adjustments remain intact.

Local Adjustment Layer Details
Local adjustment layers all contain the same basic options and controls. The primary controls are for 
applying tonal and color adjustments, but there are also options for adjusting the strength of the layer 
(opacity and blending modes) and for editing and tweaking the contents of the layer’s mask. The mask for 
the adjustment layer is represented at the top of the pane. Clicking on the mask icon will open the Masking 
Control Options section (see page 55)

In addition, the top of each local adjustment layer includes the following options:

• Opacity: Sets the opacity of the adjustment.

• Styles: The pane has a number of styles for you to start 
with, including ones for lightening or darkening, adding 
vibrance, fixing teeth or red eye, and more. (You can also 
save your own styles via the More pop-up menu.)

The main section of the Local tab has basic tonal and color adjustment options: Exposure, Contrast, 
Highlights, Shadows, Detail, and Color Temperature, Tint, Saturation and Vibrance. In addition to those 
settings, the local adjustment pane includes a Noise slider, designed to help reduce noise on a targeted 
level (most often seen in the shadows).

TIP: You can name each adjustment layer by double-clicking on the word 
‘Adjustment’ in the pane. This can be helpful when you have a lot of adjustment 
layers and wish to remember which adjustment did what.

PAINTING WITH COLOR

The Paint with Color option at the bottom of the local 
adjustment panel lets you use the Local Adjustment 
brush to select a color and paint it into your image. It 
is designed for two situations: when you wish to apply 
softening (or evening out) to portions of an image by blending existing color, and to replace the color of an 
existing object. 



ON1 Sky Swap AI 2023 User Guide	 Part 3: Using Local Adjustments	 64

The Paint with Color section has three options, Solid Paint, Replace Color, and Classic, and a color swatch 
for the chosen color. You can choose a color from your image by clicking on the eyedropper icon, or you 
can click on the swatch and choose a color from the system color picker. 

Solid Paint will paint over anything you brush with the chosen color; think of it as painting with a Normal 
blending mode. Replace Color will replace the hue, but not the luminosity, of the color you are brushing 
over; it is essentially painting with a Color blend mode, in which whites are preserved. 

The Solid Paint option is an ideal skin softening tool; use the eyedropper to select a midtone section of skin, 
and, using a low opacity setting, paint over parts of the skin with the brush. 

USING CUSTOM BRUSHES TO ADD OVERLAYS TO PHOTOS

One specialized use for local adjustment layers and the Paint With Color’s Solid Paint option is to add 
overlays with custom brush shapes. You can paint in stamps, watermarks, and other shapes to create 
specialized creations or enhanced photos. For example, you could use a custom cloud brush to add interest 
to a lackluster sky, or you could create your own watermark and apply it precisely. Sky Swap AI comes with 
a collection of custom brushes of all kinds, and you can import any black-and-white TIF file or Photoshop-
compatible .abr brush file for use in the app, via the Extras Manager (see page 16).

Creating basic overlays with a custom brush is easy:

1.	 Create a new local adjustments layer by clicking on the Local tab.

2.	 If the Adjustment Brush isn’t selected in the Tool Options bar, select it, and choose a new 
brush from the Shape menu in the options bar.

3.	 Set the brush size and angle. In general, you’ll want to keep the Opacity and Flow high, and 
the Feather low (or 0), but that will depend upon the brush and the application.

4.	 From the gear menu, turn the Manual Spacing option on. Depending upon the brush type 
and the application, you’ll have to play with the Amount slider, but the general rule of thumb 
is, for stamped brushes, where you wish the shape to be applied singly, set the spacing 
low. If you wish to apply the brush multiple times with a stroke—and have clear definition 
between the brush shapes—set the spacing higher (see the spacing chart below for an 
illustration of the different settings).

5.	 Turn the Paint With Color option on and set to Solid Paint. Choose a color for brush, and 
paint as desired on the image.

TIPS FOR USING CUSTOM BRUSHES

• The best way to begin working with brush overlays is to practice. Use some of the default 
brushes, and play with them by adding them to a photo or blank canvas.

• Use the Brush Styles option (in the Tool Options bar) to save your favorite brushes and their 
optimal settings.

• The maximum brush size in Sky Swap is 2500 pixels.

• If you’re applying a brush as a single stamp here and there on a photo, start with a feather of 
0, and Opacity and Flow set to 100. Once you’ve set your brush size and angle, click once on 
the image.

• The Paint With Color option applies to all brush strokes made on that adjustment layer. You 
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can easily change the color via the color patch in the panel. If you want to apply the same 
stamp with different colors, create a new adjustment layer for each color.

This chart shows the effect of the Manual Spacing on a brush stroke for a star custom brush. With a spacing of 100, as you stroke, the stroke will be applied 
with plenty of space between the brush shape. With a spacing of 0, the shape will meld together as you apply the stroke. Depending upon the brush type, 
this might be acceptable for your purposes.
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PART 5: PRINTING
ON1 Sky Swap AI has a flexible print engine that can print photos at any size. You can print photos 
individually; or multiple versions of a photo, package style, on a single piece of paper. You can even print 
when using Sky Swap as a plug-in from Lightroom, Photoshop or any other supported apps. 

The print window can be opened by clicking on the Print icon in the module selector, or by selecting the 
Print command from the File menu. It has the following components:

A.	Preview: Displays the photo being printed.

B.	 View Selector: The middle two icons are not applicable inside Sky Swap, because you can 
only work with one photo at a time; the icon on the far right turns soft proofing on and off 
when you are using application-managed color.

C.	 Page view: Displays the number of pages being printed. (Not applicable in Sky Swap AI.)

D.	Printer pane: Contains options for output—printer or PDF—as well as printer, page setup, 
page size, number of copies, resolution, and printer profile and rendering intent.

E.	 Print Area pane: Contains options for fitting and selecting the print image size.

F.	 Watermark pane: For adding a watermark to printed photos.

G.	Sharpening: Options for sharpening during the print process.

H.	Print/Cancel: Print the current photo or cancel the operation.
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NOTE: The print engine in Sky Swap AI is based upon the engine inside 
ON1 Photo RAW, which has the capability to print multiple photos at a time. 
Because Sky Swap can only work with a single photo, some of the options, like 
contact sheets and some view settings, are not applicable in Sky Swap.

Printing Options
The four panes in the Print window—Printer, Print Area, Watermark, and Sharpening—each deal with a 
specific printing-related task.

PRINTER PANE

The Printer pane is where you set the printer-specific features 
for your output. It has two modes, which are chosen by clicking 
on the icon at the top of the pane: Print, which lets you print to a 
connected printer, and File, which will print the selection to a PDF. 

When choosing to output to a printer, you’ll set the specifics of 
your printer, the paper size you wish to print to, the resolution, 
orientation, and the number of copies. When choosing resolution, 
make sure that you are printing at the printer’s optimal resolution. 
Most photo printers, for example, work best with a file that 
has between 240 and 360 ppi. (Sky Swap will use its internal 
resampling engine to ensure that your photo is at the final 
resolution you choose.)

At the bottom of the pane is a section for choosing a printer-specific color profile; choose the media profile 
for the paper type you are printing to. If you wish the printer to handle the color conversion, select the 
Printer Managed Color option in the Profile list.

The rendering intent is related to the conversion of an image’s colors to fit within the color range (or gamut) 
of the printer. The default intent, Perceptual, will change all of the colors in a photo proportionally to fit 
within the printer’s range of colors. The other option, Relative Colorimetric will only change the colors out 
of the printer’s gamut, to the closest in-gamut color. Depending upon the image, you might need to play 
with the intent settings, but Perceptual is usually the best place to start. 

When choosing a specific paper profile—as opposed to Printer Managed Color—you can use Sky Swap’s 
Soft Proofing feature to look at out-of-gamut colors in your photos. Click on the soft proof icon at the 
bottom left side of the window to view the photo with your chosen paper. (See page 60 for more.)

NOTE: Sky Swap’s Print feature will work with borderless printing options as 
well. Be sure to choose your printer’s borderless options in the page setup 
pop-up. Different printers will have specific borderless settings, so check the 
manual to see how to turn borderless printing on.

The Printer pane sets printer-specific options for 
the current print job. You can also choose to render 
the print job to a PDF file.
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Printing to a file

In addition to sending images to a printer, you can also choose to export the current print job to a file. This 
can be helpful if you are submitting prints to an online service or to print remotely.  To use this option, click 
on the File icon at the top of the pane. Sky Swap will ask you for a filename and a location to save the file. 
Choose a page size for the file from the Page Size pop-up, and adjust your print area settings. When you 
choose Print, Sky Swap will create a PDF of the photo (or photos) and save it with the name and destination 
you specified earlier.

PRINT AREA PANE

The Print Area pane is where you set the options for the size of the 
print, and how you wish your photos to be printed. You can also 
choose whether to print photos individually or package-style. (The 
contact sheet option, while present, is not applicable in Sky Swap, 
as it is largely designed to gang-print a set of different photos.)

The top of the pane includes preset styles for either fitting the 
current photo inside the size of the print, or filling the entire size 
of the print. It also includes options for printing at common print 
sizes, including 8x10, 5x7, 4x6; and options for printing to a contact 
sheet. You can also create custom print sizes via the Custom 
section at the bottom of the pane; just set the width and height of 
the print size, and whether you wish to fit the image to the print 
size, or to fill the frame with it. If you would like to save this print 
size as a style, click on the More pop-up at the top of the pane, and choose Save as New Style from the 
menu. You’ll then be able to recall that style from the More pop-up whenever you print.

If you are printing multiple copies of a single photo, Sky Swap will attempt to put as many photos at your 
chosen print size on the paper size as defined in the Printer pane. To print only one photo per page, click 
that option at the bottom of the Print Area pane.

Page size vs. print size

It’s worth understanding the distinction between the page size and the print size. In some cases, the two 
will be identical. For example, if you wish to print on 4x6-inch photo paper, you would choose that option 
in the Printer pane’s Page Size pop-up, and then 4x6 in the Print Area’s Custom pop-up. Depending upon 
the aspect ratio of your photo, you then might need to choose Fit or Fill to get the proper crop. Fit does 
exactly what it sounds like: it will fit the entire photo within the bounds of the photo’s dimensions, which 
means that there could be some extra white space around the final print. Fill will resize the photo to fill the 
dimensions of the chosen print size, centering the image. 

In our example, a 4x6-inch print has an aspect ratio of 2:3. If the photo you are printing has that aspect 
ratio, then Fit and Fill do the exact same thing: the photo will fill the print area without any cropping.

For package printing, where you wish to generate multiple prints on a larger sheet of paper, you’ll set the 
specific size paper you are printing to in the Printer pane, and then set the appropriate print size for each 
photo in the Print Area pane.

The Print Area pane is for setting the actual print 
size of the photo or photos you are printing.
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WATERMARK PANE

The Watermark pane adds an overlay to the printed image, and is 
most often used for your logo, signature or copyright. Watermarks 
generally need a transparent background, so make sure your 
watermark file is a PNG or PSD.

The module has the following options:

• Choose: Click the Choose button to select the file you 
wish to use as your watermark. Once you’ve added a 
watermark file, it will be saved to the Logo File pop-up.

• Size: This slider controls the size of the watermark file.

• Inset: This will determine the percentage in which the 
file is inset from the edge, based on the Position (see 
below).

• Opacity: This sets the opacity of the watermark.

• Position: This grid sets the location of the watermark. 
Click on the square of the location you desire.

When working with watermarks, make sure your watermark file 
is sufficiently large for your usage. For example, if you want it to 
appear 2 inches wide on a 300-ppi image, your watermark needs 
to be at least 600 pixels wide. Otherwise, it could appear pixelated 
on the print.

SHARPENING PANE

In most cases, and depending upon the media type you print 
to—glossy papers often benefit from additional sharpening, for 
example—you’ll need to add an additional sharpening step when 
printing. This is an additional level of sharpening beyond anything 
you might have applied in another app. 

The Sharpening pane lets you select a type of sharpening that will 
be applied to your photos during the printing process. The pop-up 
menu has a set of options for general sharpening, including ones 
for a standard print, glossy papers, details, high-pass sharpening, 
and many more. Depending upon the image, you might need to play with the settings here; performing test 
prints on small sections of a photo can often be quite helpful in determining the proper level of sharpening 
in a print.
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PART 6: EXPORT AND SHARING
Export is a special function that is available inside ON1 Sky Swap AI 2023. The Export window 
gives you the power of ON1’s patented Resize technology in an easy-to-use panel, letting you 
export your photos with incredible flexibility, ease and control.

The Export window is separated into two panels: Export Presets and Export Options. The 
Options panel contains specific types of options—file renaming, destination folders, file type and more—
that you can use when you are exporting images from Sky Swap. If you find that you are using a specific set 
of options all the time for your workflow, you can create a preset and apply that whenever you use Export.

The contents of the Export window include:

A.	Export Presets: The current preset (if used), will be represented with a selection box around 
it, and the filled circle to the left of the preset name means that it will be used when the 
Export button is pressed. To use the Export Options panel without any preset applied, turn 
off all of the presets in the list, and click in the current preset once.

B.	 Save Preset: Lets you save the current set of export options as a preset.
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C.	 Naming: Renames the exported file based on criteria added to the rename box in the panel.

D.	Destination: Lets you set the destination of the exported files. (required)

E.	 File Type: Sets the file type for each exported file. (required)

F.	 Resize: Adjusts the size for each image. 

G.	Sharpening: Applies sharpening to the exported images.

H.	Metadata: Adds/removes metadata from the export. 

I.	 Watermark: Lets you add a text or graphic watermark to an exported image. 

J.	 Export/Cancel: Starts the exporting, or cancels it and returns you to Sky Swap.

 Export Options

NAMING

The Naming pane gives you extensive controls for creating customized filenames using tokens in the entry 
box inside the pane, as well as with any custom text entered directly into the entry box. You can use any 
combination of tokens and text in the entry box, and the Example label directly above the box will display 
what your new filename will look like, using the 
first item in the export group.

To use this feature, click the control circle to the 
left of the label in the panel. Add any custom 
text, or click the Add Token pop-up menu to add 
tokens based on information associated with the 
image, including filename data, date and time 
information, and associated metadata There are 
four submenus in the Add Token menu:

• Filename, which includes options for using the original filename, number suffix (taken from 
the image as recorded by the camera) and enclosing folder name.

• Date/Time, which includes a list of date (year, month, day) and time data that can be 
combined in various ways.

• Sequence is intended for batch processing of images. (Not applicable when exporting from Sky 
Swap, which processes a single image at a time.) 

• Metadata, which lets you add specific EXIF and IPTC metadata to the filename.

To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 
above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file. Each change you make will be updated automatically in the Example label.
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The Presets pop-up menu at the top of the Rename window includes a set of common token combinations 
that you can use as a starting point. You can also create your own batch-rename presets: build the rename 
options you wish, and choose Save New Preset from the bottom of the Presets menu. You can also update 
an existing preset and delete presets from this menu.

Because the Rename process is not undoable, make sure you use the Example field to check that your text 
and token combinations give you the filenames you expect for your batch process, and adjust as needed. 
When you’re sure, click Apply, and Sky Swap will rename all of the files.

NOTE: A complete list of the tokens used in the Rename window, with 
explanations, can be found starting on page 77.

DESTINATION

The Destination pane is where you set the 
desired location for the exported images. At 
minimum, you must specify a destination folder 
for your export, but the pane has a number of 
options for adjusting the export location:

• The Folder pop-up menu lets you 
choose the same folder as the original 
images, another folder, or, can be set 
to ask for a destination every time, 
which can be helpful when you’re 
using an export preset.

• Checking the Put in Subfolder option 
will export the images to the folder—
or, create a new folder, if it doesn’t 
exist—specified by option’s text field.

• The Existing Photos pop-up is for 
those times when there might be a 
naming conflict within the destination 
folder. Replace will overwrite the file 
with the new one being exported, Skip 
will leave the destination file alone 
and not export the new file, and Keep 
Both will add a number ‘1’ to the end of the filename of the exported file, preserving both 
files.

• Generate Subfolders will subdivide the export based on the exported file’s metadata, 
creating subfolders as necessary—or, if the folders exist, placing the exported file into the 
appropriate subfolder. This option uses the same token-driven scheme (and presets) used in 
the Naming pane.

• After Export lets you determine what to do when Sky Swap completes the exporting process. 
Options include displaying the image location in the macOS Finder or Windows Explorer, to 
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create a ZIP archive of the exported group, to open in another editing application, or to run a 
script.

FILE TYPE

Like Destination, File Type is the other required 
element for using Export. Sky Swap can export 
in DNG, PSD, TIFF, JPG and PNG formats. With 
the exception of DNG and PNG, each file format 
has specific options in the pane:

• Original includes options for embedding metadata and saving an ON1 sidecar file with the 
exported images.

• JPEG includes options for JPEG quality and for attaching a color profile.

• Photoshop includes options for attaching a color profile, bit depth, and whether to flatten 
any layers in the original image.

• TIFF includes options for image compression (none, LZW or ZIP), attaching a color profile, bit 
depth, and to preserve transparency.

• DNG and PNG have no additional options.

The File Type pane also includes an estimated file size for the first item in the group.

RESIZE

The Resize pane lets you adjust the finished 
dimensions of the exported photos, using the 
patented Genuine Fractals technology found 
in ON1 Resize. It has seven options for export: 
Dimensions, Long and Short Edge, Width and 
Height, Megapixels and Percentage. Each option 
has a different range of settings, and all have a 
setting for resolution (in pixels per inch, or ppi), as well as a Don’t Enlarge option, which, when set, will not 
upscale a file past its native image dimensions (but will still export the file). 

The Dimensions option is the most complex of the six Resize options, letting you set the exact pixel 
dimensions of the exported files, in terms of width and height. This option is best for when you are 
exporting single images, when all of your exported files have the same aspect ratio and orientation, or 
when you wish to fit the exported images to an exact size. 

The Common Sizes pop-up menu at the top of the pane options lets you set the final dimensions to any of a 
broad array of common paper, photographic ratio, square and video formats. You can also create your own 
specific sizes for re-use via this menu.

Click the lock icon to resize the images proportionally as you enter either the width or the height, or, if 
you wish to fit the images to an exact width and height, click the lock icon to turn it off. If an exported 
image doesn’t exactly fit the dimensions you set for Width and Height, Export will do one of two things, 
depending upon whether you have Fit in Dimensions or Fill Dimensions set in the pop-up to the right of the 
Resolution box.

The Resize pane, with the Dimensions option open.
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• Fit in Dimensions will fit the exported file inside the boundaries of the width and height 
settings.

• Fill in Dimensions will zoom the exported image to completely fill the boundaries of the width 
and height settings, essentially cropping the exported image. If the image’s aspect ratio is 
different from the width and height settings, the image will be filled from the center. 

The Dimensions options include one more setting, Rotate to Match Photo, which, when checked, will rotate 
an exported photo to maximize its orientation. For example, if you exported a group of images to fit a 
landscape orientation (longer width than height), any image that was in portrait orientation (longer height 
than width) would be rotated during export.

The remaining options in the Resize pane include:

Long Edge and Short Edge are useful when you want to lock one edge to a 
specific length or width and don’t care about the sizing of the other edge. 
Simply choose which option is the important one for your photos, enter the 
dimension, and Export will resize your images proportionally based on the 
chosen setting. When you’re exporting a group of images with different 
orientations (landscape or portrait), these options will ensure that all images 
have the same long or short edge dimension.

Width and Height will resize all of the images proportionally to the width 
or height defined, regardless of orientation. Exporting photos with different 
orientation will result in the width or height of every image being the same, 
depending upon the setting chosen.

Megapixels will export images to a specific megapixel count, while Percentage will enlarge or reduce the 
size of the exported images. Percentages below 100 will reduce the image, while those above 100 will 
enlarge the image.

SHARPENING

The Sharpening pane has two modes, Sharpen 
For and Manual. The Sharpen For pop-up 
menu lets you choose from six options, based 
upon your final intent. There are four options 
designed for print output, Glossy Paper High 
and Low, and Matte High and Low, and two 
option for display output (for social media or 
online sharing), Screen High and Low.

The Manual setting provides a bit more control 
over the output sharpening, letting you adjust 
the Amount (overall strength), Radius (detail) and Threshold (masks out areas that shouldn’t be sharpened 
based on contrast). 

Resize has seven options for 
exporting images.
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METADATA

The Metadata pane lets you set which pieces of 
metadata are exported—or not exported—with 
the images in the export set. You can choose to 
export all Metadata or by clicking the control 
circle to the right of the All Metadata label. 
If you click that label off, you can then select 
which metadata items you wish to save by 
clicking the appropriate label.

When checked, the Remove Unmanaged XMP 
button only exports metadata that ON1 recognizes as standard metadata fields; any unmanaged image 
metadata from other apps will not be included. 

WATERMARK

The Watermark pane adds either text- or graphics-
based watermarks to an image, with options for 
size and positioning, opacity, font type, and more. 
You can import your own logos and save either 
watermark type as a preset for frequent use. 

The Watermark pane also gives you a representation 
of your chosen watermark (on the first image in your 
export group), so you can adjust the parameters of 
the watermark precisely.

To create a new watermark, turn on the pane by 
clicking on the control circle to the right of the label. 
Choose either a preset from the Presets menu or 
click on the Add Watermark button in the lower 
right of the pane and choose either Text or Logo 
from the pop-up menu. Once you’ve selected a type, 
the bottom of the pane will open with settings for 
the chosen option. If you change your mind, click the 
Cancel button to the right of the Logo or Text labels.

Using graphics-based watermarks

The Logo section of the Watermark pane lets you 
use either watermark files imported via the Extras 
Manager (see ), which will be displayed in the File 
pop-up at the top of the Logo section, or by clicking 
on the Import button to the right of the menu (which 
will add them to the menu). 

Use the Position grid at the bottom of the pane to 
place your watermark, and use the Size and Inset sliders to move it within the area chosen. The Opacity 
slider adjusts the transparency of the watermark on the final image.
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The Repeat Image button will repeat the logo graphic rightward across the image from the location chosen 
in the Position grid. If you wish to repeat the watermark across the entire image, choose one of the sections 
on the left side of the Position grid.

When working with graphics-based watermarks, make sure your watermark file is sufficiently large for 
your usage. For example, if you want it to appear 2 inches wide on a 300-ppi image, your watermark needs 
to be at least 600 pixels wide. Or if you want it to appear across an entire photo—such as when posting 
to social media—it needs to be the same size as what you are exporting for the web, typically over 1000 
pixels. Using a watermark file that is too small will create a pixelated watermark appearance. And, because 
most watermarks are overlays on top of an image, these files are usually PNGs with areas of transparency, 
although JPGs can also be used, depending on the logo.

Using text-based watermarks

When creating text-based watermarks, the Text 
section of the pane has an entry box for your 
watermark text, a font selection area, and the same 
Appearance and Position options found in the Logo 
section.

The text entry box can contain multiple lines of 
custom text, and has the same token-based naming 
options found in the Naming pane (discussed on 
page 71), which can be helpful when exporting 
informational slides or for other data-driven uses.

You can set the font from the pop-up menu, and 
the font color by clicking the swatch on the left side 
underneath the font name. The text style can be 
set to bold, italic or underline, and the alignment to 
left, center or right. If you’d like to add a background 
color to the text box, turn on the Color Fill button 
on the right side of the pane.

Use the Position grid at the bottom of the pane 
to place your watermark, and use the Size and 
Inset sliders to move it within the area chosen. 
The Opacity slider adjusts the transparency of the 
watermark on the final image.

Saving watermark presets

Both watermark types can be saved as a preset 
for re-use later. To save a preset, adjust your Logo 
or Text settings as desired, and choose Save New 
Preset from the Presets menu. If you wish to adjust 
an existing preset at a later time—with a new logo 
file, for example—choose the appropriate preset 
from the Presets menu, make your changes, and 
choose Update Preset with Current Settings from the Presets menu. You can also rename and delete 
watermark presets from this menu.

With text-based watermarks, you can not only create simple, single-line 
watermarks showcasing your business, but you can also create 
data-driven watermarks (using tokens) for presentations and the like.
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Exporting and Export Presets
The Export window has been designed to offer as much or as 
little complexity as you would like. At its simplest, you can set the 
Destination and the File Type to your desired settings, leave all of 
the other panes alone, and click Export. Sky Swap will remember 
your last Export setting—including anything you did in the Naming 
pane—the next time you export, so you don’t have to worry about 
which settings need to be set, and which ones don’t. You can use 
the Show/Hide buttons in the title bar of each pane of the Export 
Options panel to display only those settings you want to see.

Once you have your settings the way you’d like, you can save them 
as a preset by clicking the Save Preset option in the Preset panel 
on the left. Then, when you click that item in the Preset panel, the 
Export Options will be set to the specifications of that preset.

The Export Presets panel will display a list of the currently 
available presets. If you have selected a preset, it will have a 
selection box (in the app’s accent color) around it, and if the control 
circle is filled, the preset is on, meaning that clicking the Export 
button will export using that preset. If you don’t wish to use a 
preset, click the control circles off on all of the presets in the list.

By default, each preset will have up to three lines of explanatory 
text underneath the preset name, displaying the file type—DNG, 
PSD, TIFF—and the Destination information. This can be helpful 
when you’re scanning presets for a specific destination, but you 
can also collapse the preset to its title by clicking the Hide button 
in the title bar.

When you change the settings for a selected preset, Sky Swap 
will ask you if you wish to update the preset with the new settings 
either when you click the Export button to start the process, or 
when you switch to another preset with the Export window.

It is possible to export more than one preset at a time. Every preset 
in the Presets panel that has the control circle set to On (filled) will 
be included in the export operation. This might be helpful to create backups on another disk, for example, 
or to build proxy versions for use while the original is being edited.

About Sky Swap’s File-Naming Tokens
When using the Naming option in the Export window, Sky Swap includes a broad set of tokens that you 
can use as part of the strings to build complex file names, in conjunction with any custom text you wish 
to enter. These tokens draw on image metadata, including filenames, dates taken, and EXIF and IPTC 
metadata fields, and can be used in any number of combinations.

All presets include an informational view that lists 
the export file type, the destination folder, and 
resize information. If you don’t wish to see that, 
click the Hide button to collapse the view to just 
the preset title.
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To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token 
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item 
above the text field will show a sample of a renamed file using the current set of tokens and custom text. 
To change an existing token, click on the down arrow on the right of the token, which will display the full 
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end 
of a token (or in-between tokens) and add spaces, dashes, underscores and any other text you wish to be 
included in each renamed file.

There are four categories of tokens, each with their own set of options: Filename, Date/Time, Sequence, 
and Metadata. A description of each is listed below.

FILENAME

The Filename tokens use information from the 
filename or the enclosing folder that the file resides 
in. There are three options, Filename, which adds the 
current filename of the file being worked on; Filename 
Number Suffix, which takes the index (shot) number 
from the original raw file, if available; and Folder Name, which grabs the name of the folder in which the 
renamed (or imported) file resides.

DATE/TIME

This submenu consists of 17 combinations of date and 
time data, as taken from the image’s metadata. There 
are prebuilt date and time combinations (20220104, for 
example, for a year-month-date token) in the list, or your 
can build your own combinations out of the subtokens 
listed in this menu. 

Year data can be presented in either 4- or 2-digit 
numbers, and Month data can be presented in month 
number, full name, or 3-letter abbreviations.

You can use a combination of tokens and custom text to rename files to exacting specifications, all 
drawn from file information, metadata and more.
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SEQUENCE NUMBER

The Sequence Number tokens come into play when exporting, importing or renaming a group of image 
files, and, as such is not applicable within Sky Swap.

METADATA

This submenu has five items, each with its own submenu. 
All of the items create the chosen token based on the 
embedded metadata for each image being renamed, 
imported or exported. The specific text pulled from the 
Camera and IPTC tokens will be visible in the Metadata 
pane’s EXIF (for camera-specific data) and IPTC (for IPTC 
data) tabs. The Ratings and Labels tokens are taken from any 
you have applied in Sky Swap. 

NOTE: If there is no information in the specified Metadata token, it will be 
ignored during processing.

Camera

The Camera submenu includes 21 items, all of which are 
directly taken from an image’s EXIF data. Not all cameras 
capture all of the items listed, but most of them save essential 
items like exposure information, focal length and more.

Ratings and Labels

The three tokens in the Ratings and Labels submenu (shown 
below) pull information from any rating, label and like 
information stored with images opened in Sky Swap.

The Rating token will add the number of stars an image 
is rated, while the Label token will add any color label 
information (red, yellow, green, blue, purple), and the Likes 
token will add Liked, Not Set, or Disliked to the image name.
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IPTC Metadata Tokens

IPTC (International Press Telecommunications Council) is an industry-standard metadata format, and offers 
much more detailed metadata information than EXIF. It historically has been used by journalists and stock 
photographers to catalog and tag photos, as well as add copyright information, captions, and other data. 
There are nearly 30 different tokens in the IPTC metadata submenus, which are divided into Contact, 
Content, and Image. You can use these tokens if you know that an imported file has stored IPTC Metadata 
information.   
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Other Sharing Options (macOS Only)
The macOS version of Sky Swap AI includes other photo-sharing options, including:

• Mail: Creates a new email message in Apple Mail with the shared 
photo.

• AirDrop: Uses Apple’s AirDrop networking feature to share with 
local macOS or iOS devices. 

• Notes: Adds the shared photo to Apple’s Notes app. You can 
choose to create a new note, or add the photo to an existing note.

• Messages: Shares photo to Apple’s Messages app.

• Add to Photos: Adds the photo to Apple’s Photos app.

• Reminders: Adds the photo to a new reminder.

• Dropbox Transfer: Initiates a Dropbox Transfer operation, if Dropbox is installed on your 
computer.

All of the sharing options perform the same operation: Sky Swap exports a full-size JPEG of the selected 
photo and shares it with the selected target from the list.
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EDIT MENUS
ON1 Sky Swap AI (macOS Only)

• About ON1 Sky Swap AI: Opens the About box and displays 
your version number. (This is in the Help menu on Windows)

• Preferences: Opens the preferences dialog. (In the Edit menu 
on Windows)

• Quit ON1 Sky Swap AI: Quits ON1 Sky Swap AI.

File Menu

• Done: Saves your edited photo and quits Sky Swap.

• Cancel: Cancels the current editing operation.

• Quick Export: Saves the current image in Photoshop, TIFF, 
JPEG or PNG format.

• Export: Opens the Export window.

• Export with Previous: Exports the current selection with the 
last-used Export setting, bypassing the Export window.

• Print: Opens up the print dialog box.

• Manage Extras: Opens the Extras Manager window.

Edit Menu

• Undo: Removes the last file operation.

• Redo: Redoes the undo operation. This is only available if the 
last thing you did was an undo.

• Cut: Cuts the currently selected item.

• Copy: Copies the currently selected item.

• Paste: Pastes (copies) the items in the clipboard to the current 
location.

• Revert: Reverts to the original state of the current photo.

• Keyboard Shortcuts: Lets you customize the hotkeys used 
inside Sky Swap AI.

• Preferences (Windows): Opens the Preferences dialog.
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Photo Menu

• Rotate 90 Degrees CW: Rotates photo clockwise 90°

• Rotate 90 Degrees CCW: Rotates photo counterclockwise 90°

Settings Menu

• Reset All Settings: Resets all of the settings applied to a 
photo, returning it to the state it was when opened.

• Reset Sky Settings: Resets settings applied in Sky Swap.

• Reset All Retouching Tools: Resets retouching applied in Edit. 

• Reset Local Adjustments: Removes all local adjustment layers 
added to a photo.

• Reset Crop: Resets any cropping made to a photo.

• Save Settings: Saves the current state of your edits, in case of 
crash.

View Menu

• Zoom In: Zooms the preview window in one increment. This 
will make the preview image larger.

• Zoom Out: Zooms the preview window out one increment. 
This will make the preview images smaller.

• Fit to Screen: This sets the preview image so that the entire 
image is on screen at once. Think of this as an overview of the 
entire image. This is the setting you will use most of the time.

• Actual Pixels: This sets the preview image so that it zooms to 
actual pixels or 1:1 also called 100%. 

• Show Clipping: Shows the clipping overlay view, displaying the 
pure white or black pixels in the current image.

• Show Focus Mask: Displays a green overlay on those portions 
of the current image that are in focus.

• Show Preview: Toggle to enable or disable the preview.

• Compare: Displays an adjustable split-screen view of the 
current image, with the Before view on the left side of the 
preview area.

• Preview Background Color: Lets you set the background color 
options.

• Enable Soft Proofing: Turns on soft proofing for the current 
image.

• Gamut warning: Displays colors that the printer can’t 
reproduce with a red overlay.

• Profiles: Displays a list of installed printer and display profiles; 
choosing a profile will apply soft proofing for that profile’s 
paper type.
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• Intent: Lets you switch between perceptual or relative 
rendering intent for the current image.

• Simulate Paper and Ink: When turned on, Sky Swap AI will set 
the white point and black point of the display to account for 
that of the chosen profile.

Window

• Minimize: Minimizes your screen.

• Zoom: Zooms your window to full-size.

• Full Screen: Toggles full-screen mode (hides menus).

• Navigator: Hides or shows the Navigator, Loupe, Histogram 
and Info pane.

• Solo Mode: Keeps only one pane open at a time.

• Show Bumper Labels: Hides/reveals the text labels in the 
module selector.

• Show Control Panel: Hides/shows the Control Panel.

• Hide Panels: Hides or shows all Panels.

• Document Name: Shows the name, zoom level and bit depth 
of the open image.

Help

• Search: Searches the menu options (macOS only).

• Learning Hub: Launches the Learning Hub inside Sky Swap AI.

• ON1 Sky Swap AI Online Help: Opens ON1.com support page 
in your default web browser.

• Video Tutorials: Opens ON1.com product training page in 
your default web browser.

• Check for Updates: Checks with the ON1 update server to 
see if you are running the current version. If there is a newer 
version, you will be notified and be walked through the 
update process.

• Sign-In/Sign-Out: Uses your ON1 account login information 
to authenticate your copy of ON1 Sky Swap AI.

• Provide Feedback: Opens the default web browser and goes 
to the feedback page of the ON1 website.

• About ON1 Sky Swap AI (Windows Only): Opens the about 
box with the version number displayed.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Show ON1 Log: Diagnostic tool that can help ON1 support 
when you’re having issues with ON1 Sky Swap AI.
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PREFERENCES
ON1 Sky Swap AI has a number of system-wide settings that you can set via the Preferences window. To 
access Preferences, either click on the gear icon at the lower left side of the screen, or choose Preferences 
from the ON1 Sky Swap AI menu (macOS) or the Edit menu in Windows. The Preferences window has four 
tabs: General, Files, Plug-Ins, and System. 

GENERAL SETTINGS

The General settings tab adjusts basic settings 
for the Sky Swap AI workspace, including 
background color, scrolling controls and more.

Font Size

Sets the size of the text in the basic Sky Swap AI 
workspace (labels, panes and pop-up menus) to 
one of three general sizes: Small, Medium, Large. 

NOTE: When changing the font size, you must quit and restart Sky Swap for 
the the new setting to take effect.

Preview Background Color

You may select the color of the background behind the preview image. The default is black. The custom 
option has a color picker where you can select your own background color.

Accent Color

Lets you choose the display color for highlighted items (folders, tabs, selections) in the Sky Swap AI 
interface.

Application Language

Lets you change the display language for Sky Swap AI. Auto will use your system’s default language (if 
available).

Check for Update on Launch

Enabled by default, the product will communicate with ON1’s software update server when you start ON1 
Photo; if an update is available it will prompt you to download or skip.
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Only Adjust Brush Size with Scroll Wheel

Turning on this option overrides Effects’ default behavior, setting the app so that your mouse’s scroll wheel 
will only change the size of a brush (when an appropriate tool is selected). 

When not checked, Effects uses the scroll wheel to scroll, zoom, pan and adjust brush size and feathering, 
depending upon the modifier keys being pressed. See page 18 for specifics on the default settings for 
scroll wheel options in Effects. 

FILES

Sidecar Options

Click this box if you wish ON1 Sky Swap AI 2023 
to create ON1-specific ‘sidecar’ files when you 
are editing images. This is helpful if you are using 
multiple computers (on an external hard drive, 
for example), and want your edits to be visible 
on each machine when you reopen a retouched 
photo.

Default Processing

Apply Lens Correction Automatically will use lens correction information automatically on any raw photo 
opened in ON1 Sky Swap. Choosing Disable Base Corrections on Raw Files will turn off the basic raw-
file correction settings. This can be helpful for scientific/technical photography, time-lapse, and other 
specialized applications.
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PLUG-INS

Plug-Ins is specific to using Sky Swap AI as a 
plug-in Photoshop or Lightroom, and lets you 
set up conditions when opening files from these 
apps.

General

Checking the “Leave ‘ON1 Sky Swap AI 2023’ 
option when done will keep the app open after 
you’ve edited an image via a plugin.

Photoshop

• Apply Results to: When editing in 
Photoshop you can choose to have your 
effect added to a copy of your current 
layer or to the current layer. You can also 
choose to start with the last used settings 
when launching Sky Swap AI.

Lightroom

This preference lets you choose the specific options for files opened via the Plug-In Extras menu in 
Lightroom:

• File Type: The file type drop-down menu determines what type of file will be created. The default is 
PSD, which maintains layers. You can also select ON1’s Smart Photo format to preserve re-editability 
from within Lightroom, and JPG or TIFF if you prefer those formats. The last option is same as source, 
which maintains the file type of the original file, except for raw files, which are saved as PSDs.

• Color Space: Sets the working color space; Adobe RGB, sRGB or ProPhoto RGB.

• Bit Depth: Sets the file bit depth, either 8-bit or 16-bit per pixel.

• Resolution: The resolution drop-down menu determines the resolution of the file.

• Stack with Original: When enabled, the new image is stacked with the original image.

• Use Original for Single PSDs: When enabled, if you select a single PSD file, it will be edited directly, 
rather than having a copy made.

• Ask Every Time: Presents these export options whenever you chose an item from the Plug-In Extras 
submenu. Turning this option off will bypass the file-export window, using the options in the Plug-In 
Preferences window every time.

NOTE: For detailed information about the Smart Photo format and re-
editability options from within Lightroom, see “Working with Smart Photos” on 
page 11.
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Apple Photos (macOS only)

• The Enable Helper option works to ensure a smooth connection between Apple Photos and Sky Swap 
AI. It should remain on by default.

SYSTEM

The System tab displays performance-related 
characteristics of Sky Swap AI.

AI processor

Sets the processing option for AI-based 
operations. By default, the option is set to Auto, 
which uses the best combination of system 
resources to process tasks. If you are noticing 
some performance issues with Sky Swap AI, you 
can try setting the options to either your CPU or 
your graphics card.

Memory Usage

• System Usage: Specifies the amount of RAM that is used by the application. The maximum (default 
value) is 80%.

• VRAM Usage: Specifies the amount of video memory (VRAM) that is used by the application. The 
maximum (default) is 80%.

Scratch Folder Location

This setting lets you move or reset your memory cache, which helps speed editing operations while you’re 
running Sky Swap AI. This is helpful if your system drive has limited space and you wish to use a faster 
external drive as a cache. This cache information is purged each time you quit the application.

Performance

The Performance section is designed to help you optimize Sky Swap AI for your specific setup. The 
adjustments you can make are as follows:

• Video Card Strength balances updating the preview of the image and the movement of brushes and 
gradient tool overlays. If your brush is sticking try turning it down. If you have a high-end video card try 
turning it up for faster preview updating.

• Fast Panning reduces the preview quality (makes it less sharp) while panning the photo to improve 
performance of panning.

• Fast Preview reduces the preview quality (makes it less sharp) while painting or making other 
adjustments to improve paintbrush performance. This is off if you have a high-end video card.
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• GPU Render uses the GPU (video card) to render preset thumbnails, exporting, printing, sharing and 
caching. This can greatly improve performance. It is on by default for systems that support it. It may be 
disabled on lower-end GPUs.
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